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VMETRO
Preface

This User Guide explains the process of preparing, installing, and using your Vanguard. It is 
divided into the following sections:

• Product Overview
• Hardware Description

• Getting Started with BusView®

• State Analyzer
• Statistics Functions
• Protocol Checker
• Exerciser
• Simulator
• Appendixes: Specifications, Signals.

Style Conventions Used
• Code samples are Courier font and at least one size less than context.
• Directory path names are italicized.
• File names are in bold.
• Absolute path file names are italicized and in bold.

Symbols
Tip – This information offers guidance in using your Vanguard for certain situations.

Warning! Information contained in this box must be observed. It will provide 
information about situations that may be dangerous.

Note – Information contained in this box is important and will help you get the best performance 
from your Vanguard.
vIssued May 4, 2004 Vanguard User Guide



VMETRO
Quality Assurance

VMETRO is dedicated to supplying our customers with products and services of the highest 
quality. 

We therefore, continually review and assess our products and services with the aim to improve the 
processes involved in the development of our world-class products.

If you have any comments or feedback with respect to our products and services, please feel free to 
contact us through the support channels listed here, or email us at analyzercomments@vmetro.com

Technical Support

Please see the section Technical Support at the end of this guide.

Related Documentation

Installation Guide
vi Vanguard User Guide Issued May 4, 2004
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VMETRO
 1 Product Overview
sued M
This section gives a broad overview of the Vanguard.

• Overview
• State Analyzer
• Protocol Checker
• Statistics Functions
• Exerciser
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Product Overview VMETRO
1.1 Overview

VMETRO is a company totally committed to building the finest bus analyzers, and is recognized in 
development laboratories around the world as providing superior tools for developers and 
manufacturers of bus based computer equipment.

The Vanguard is the result of more than 15 years experience in building bus analyzers. The 
Vanguard Analyzer has evolved through four generations of VME bus analyzers, five generations 
of PCI bus analyzer and two generations of PCI-X analyzer.

A bus analyzer is a pre-configured logic analyzer designed as a plug-in card conforming to the 
logical, electrical and mechanical specification of the target bus.

The primary use of a bus analyzer is to monitor the activity on a back plane bus and provide a trace 
of bus cycles between modules. This information is then presented as alphanumeric trace lists or as 
waveforms.

This is done without connecting and configuring large numbers of probes to the back plane, a time-
consuming and error-prone process necessary with general-purpose logic analyzers.

Statistical analysis of a bus system provides extensive performance monitoring in real time. This 
analysis can identify latencies, device throughput measurements and efficiency.

The Vanguard also includes an on board Exerciser unit that allows you to generate traffic, emulate a 
target, and generate interrupts.

The built-in protocol checker detects protocol errors and bus anomalies without the need for 
detailed knowledge of the VME bus specification.

Vanguard

The Vanguard product family provides a suite of tools for use in developing, testing and fault-
finding in chipsets, motherboards, add-in boards and software which use the VME Bus.
The tools are controlled through a Windows-based program called BusView®.

The Tools

The tools are categorized as follows.

• State Analyzer: Bus sampling and analysis. 
• Protocol Checker: Detects bus protocol violations.
• Statistics Functions. Statistical representation of a number of bus performance issues.
• Exerciser: Provides a method of applying traffic (cycles) onto the bus. 
2 Vanguard User Guide Issued May 4, 2004



OverviewVMETRO
The Hardware

The Vanguard consists of a daughter card (SAM) and a carrier card.

SAM (State Analyzer Module)

FIGURE 1-1. 
SAM daughter 
card

At the heart of the Vanguard family of Analyzers lies the SAM (State Analyzer Module). 
This removable daughter card holds the Analyzer,  and Statistics Functions, and can be used 
with different carrier cards, including PCI.
3Issued May 4, 2004 Vanguard User Guide



Product Overview VMETRO
VME Carrier Card

FIGURE 1-2. 
Carrier card 
form factor

Figure 1-2 shows a VME carrier card. This card carries the SAM and the Exerciser.

The Software - BusView®

BusView is a Windows compatible program from which all of the Vanguard tools are controlled. 
Once installed onto a compatible workstation, BusView will connect to the hardware. BusView can 
be installed onto the same system in which the Vanguard is installed, or it can be installed in a 
different system.

The connection between the Vanguard and BusView is one of two types:

• Direct Connection - Connecting directly to the Vanguard via a USB cable, or a crossover 
Ethernet cable.

• Remote Connection - BusView connects to the Vanguard via Ethernet over a network.
4 Vanguard User Guide Issued May 4, 2004
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1.2 State Analyzer

The State Analyzer is responsible for sampling, storing, and displaying VME bus traffic. 

FIGURE 1-3. 
State Analyzer 
acquires bus 
signals

 

The State Analyzer will stop sampling according to “trigger conditions” and stores samples of the 
VME bus activity according to “store conditions”. A detailed description of the operation of State 
Analyzer can be found in the section “State Analyzer” on page 43.

Sampling

Once the Analyzer has been started, samples are compared against user defined trigger and store 
conditions. Storage of samples takes place in the trace buffer, which has circular memory. Once the 
buffer is full, storage continues from the beginning, overwriting what was previously stored.

FIGURE 1-4. 
Trace Buffer as 
circular 
memory

VANGUARD

Exerciser

State Analyzer
Protocol
Checker
Statistics

VME Bus

S
S-1

S+1

Current Sample

Buffer Start

Buffer End
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These stored samples are then tranferred from the trace buffer to BusView. BusView will then 
present these samples via the Current Trace window.

FIGURE 1-5. 
Current Trace 
window

 

Trigger Conditions

Triggers are defined in the TraceSetup window in BusView. 
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FIGURE 1-6. 
Setting trigger 
conditions

 

The Trigger and Trigger Position define when sampling stops. The settings found in the Setup 
Options window as seen in Figure 1-7, determine how large the trace is, where in the trace the 
trigger condition is, and how the Trigger Output should behave.

FIGURE 1-7. 
Trace buffer 
settings

Sequencer

A trigger might not only be one single event; it can also be a combination of events. The 
Sequencer is used to build more complex trigger conditions. Using familiar programming 
structures such as IF THEN ELSE combined with counters, timers and logical operators, it is 
possible to build large and complex trigger conditions via an intuitive interface.
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FIGURE 1-8. 
The text based 
Sequencer

 

A diagrammatic version of the sequencer is also available in addition to the text based 
sequencer. Both versions are coupled, so that any change made in one version will be 
represented in the other. You can switch between the text based and diagram based 
sequencer at any time.

FIGURE 1-9. 
The diagram 
based 
Sequencer
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Trace Display

Once the samples have been collected and transferred to BusView, they are viewed in the Trace 
Display window. BusView will use the samples to generate both an alphanumeric and waveform 
view of the data.

The samples are collapsable and expandable according to a transaction’s header and data. For 
example: In Figure 1-10, Sample 2387 has 14 data samples currently hidden. By left-clicking the 
mouse on the ‘+’ symbol next to the sample, the sample will expand revealing what is presently 
hidden.

FIGURE 1-10. 
Alphanumaric 
view of a trace
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FIGURE 1-11. 
Waveform view 
of a trace

 

 To help identify data phases, the Vanguard will increment the address field in the trace buffer for 
each data cycle. The start address of a data block is highlighted.

The trace display also has tools such as Search, Extract, Bookmark and Jump to help locate 
particular samples.

• Search - Locates the first sample which matches a definable search pattern.
• Extract - Extracts all samples from the current trace which matches a definable search pattern.
• Markers can be placed in the waveform diagram. These are useful for performing delta-time 

measurements.
• Jump - Provides methods to jump to particular samples based on sample number, marker 

position, trigger, and more.

FIGURE 1-12. 
Trace ToolTip 
Information

 

Contents of collapsed fields can also be viewed by resting the mouse cursor over the fields in 
question.
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1.3 Protocol Checker

The protocol checker detects violations of the bus specification. This helps uncover design, 
manufacturing and field-failure-induced flaws in both masters and targets.

It will also uncover a wide variety of hardware problems originating in other parts of a board that 
indirectly causes illegal bus activity. This is achieved by monitoring the boards that are present in 
the system configuration. This can help, for example, determine why a board from a particular 
manufacturer does not function correctly in a system from another manufacturer.

The protocol checker can also be configured to ignore "innocent" bus violations, i.e. violations that 
occur sporadically and generally do not restrict the overall system function or performance.

Each time a bus violation occurs, a fast trigger output (within 2 to 4 clock pulses depending on the 
violation) can be generated. The protocol checker can be configured to generate this trigger signal 
on the first occurrence, or on every occurrence of the specified violation. This trigger signal can 
give a direct lead to timing errors and other problems that may exist on the bus.

The difficult part of debugging is usually determining which conditions to trigger on. Often, the 
symptoms of failure give no clue as to their cause. Since all of the Vanguard tools can be used 
simultaneously, the possibility of triggering the Analyzer as result of a bus violation significantly 
enhances the versatility of the Vanguard.

FIGURE 1-13. 
Protocol 
Checker in 
grouped view
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Features

The main features of the Vanguard Protocol Checker:

• All local bus traffic is continually monitored and bus protocol violations are automatically 
detected.

• Detects 60 Protocol Violations and 3 Warnings.
• Compliant to 

ANSI/VITA 1-1994, VME64
ANSI/VITA 1.1-1997, VME64 Extensions
ANSI/VITA 1.5-2003, 2eSST.

• Can generate signals to trigger the Vanguard Analyzer or an external logic analyzer.
• Any of the tested protocol violations can be ignored by the protocol checker by de-selecting the 

specific violation in BusView.

Problems the Vanguard Protocol Checker can help uncover:

• Improper design of VME bus interface circuitry.
• Bus noise, including cross-talk, ringing and ground-bounce, leading to setup time violations.
• Two masters "fighting on the bus".
• Two targets responding to the same address.
• Invalid signal sequences and combinations.

Use of the Protocol Checker requires the “VG-P” license to have been purchased. See “Ordering 
Information” on page 241.
12 Vanguard User Guide Issued May 4, 2004



Statistics FunctionsVMETRO
1.4 Statistics Functions

The Statistics Functions offer several pre-defined statistics and the means to generate user defined 
statistics for more advanced bus performance analysis.

Pre-defined Statistics
• Bus Utilization - Displays parameters that measure bus traffic performance.
• Transfer Rate - Gives a measurement in MTransfers/Sec and MB/Sec according to Bus Level 

and Transfer type.
• Block Length Distribution - Counts the number of bytes in each transaction, and displays them 

according to block length.
• Interrupt Distribution - Displays how often interrupts are occuring.
• Interrupt Service Time Distribution - Measures the time taken for each interrupt to be serviced 

by the system.
• Arbiter Latency - Counts the average number of clock cycles from REQ# asserted to GNT# 

asserted.

FIGURE 1-14. 
Statistics Setup

 

All statistics can be run simultaneously, in real time.
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User Defined Statistics

Event Counting counts the occurance of user-selectable events. Eight events can be programmed.

Customized Charts allow for user definable performance results to be displayed. Any of the 
available counters can be used together in mathematical formula to build statistical charts to your 
own specification.

FIGURE 1-15. 
User definable 
statistics
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1.5 Exerciser

The exerciser acts as a reference unit that generates VME bus cycles with known characteristics. It 
is usually used for testing new boards or to assist in the debugging of boards. It can also load the 
system with heavy bus traffic for performance checks.

The exerciser can also be used to patch data in memory without influencing the operation of other 
masters on the VME bus.

Use of the Exerciser requires the “VG-VE” to have been purchased. See “Ordering Information” on 
page 241.

Emulation

The Exerciser can be used in conjunction with, and concurrently with, the Analyzer; providing a 
test environment in which it is possible to emulate any add-in board and get the same analysis of 
bus traffic and control issues as you would using the actual add-in board.

The Exerciser contains a target interface that has its own address decoder for a user defined address 
window which can respond to accesses from another module.

Scripting

A built-in script engine allows test scripts to be created with a convenient record and playback 
function. Scripts are recorded by manually running through the various commands of the Exerciser. 
Scripts can be stored and edited as text files where each script can consist of sequences of bus 
cycles of any kind, with varying sizes, cycle types, etc. The script playback function can be set to 
run single, multiple or infinite playbacks, while the Analyzer may perform bus monitoring in the 
background.

DMA Transfers

The Exerciser has the ability to act as a target or as an initiator with small or large DMA transfers. 
The user can run up to two different DMA transfers at the same time, and since the DMAs run in 
the background, the DMA command can be used to produce bus traffic, while other Exerciser 
commands are available for other purposes. It is also possible to set up a DMA that transfers data 
between two other agents.

Target Memory

 Data can be written to and read from this memory as single cycles. This way the Exerciser can 
emulate a device or VME board. The Exerciser also has the following properties:

• VMEbus System Controller
• Autoslot ID mechanism
• VMEbus Requestor (Level 0-3)
• VMEbus Interrupter and Interrupt handler (IRQ1-7)
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• VMEbus master/slave A32, A24, A16:D32, D16, D8, UAT
• VMEbus master/slave A32, A24:D32BLT, D64MBLT
• VMEbus master/slave A64, D32, D32BLT, D64MBLT
• VMEbus master/slave 2eSST: A64, A32
• VMEbus master/slave 2eSST Broadcast: A64, A32
• BLT/MBLT cycle 

Generate VME Interrupts

The Exerciser can generate any of the four VME Interrupts.
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 2 Hardware Description
sued M
• Vanguard VME Assembly
• Vanguard Hardware Features
• External Power
• Miscellaneous Parts
• Hardware Menu
• Moving the SAM

Note – Static electricity can permanently damage your Vanguard. Prevent 
electrostatic damage by following the static electricity precautions listed in the 
Installation Guide.
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2.1 Vanguard VME Assembly

FIGURE 2-1. 
Vanguard VME 
board layout
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2.2 Vanguard Hardware Features

LED Dot Matrix Display

When BusView is not connected to the Vanguard, the display will scroll through the 
following messages:

• IP address and Port Number on which the Vanguard accepts connections from 
BusView. 
Example - “IP: 192.168.168.40:2400”

• Device Name
• Bus Type

When BusView is connected to the Vanguard, this display scrolls through a number of user 
definable strings which are set via the Options tab in the Hardware Menu dialog. If no 
options have been set, then the display will show the voltage.

System LEDs

These four LEDs indicate the following:

External Power Connector

If an external power source is used, then the blue jumpers must be moved from Z1 and Z2 
and placed in positions Z3 and Z4.

Reset

Causes a hardware reset on the Vanguard. This reset is local to the Vanguard and does not 
affect the target system.

Note – The Device Name is only shown if a name has been given to the device using the 
Change Device Name option.

TABLE 2-1. System LEDs

LED Name Color Meaning When Lit

OK Green Flashing: Vanguard is powered-up and ready.
Solid: Vanguard is connected to BusView.

Err Red A Protocol Violation has been detected by the Protocol Checker.

Trig Yellow The Analyzer has triggered.

Exer Orange Exerciser is enabled.
19Issued May 4, 2004 Vanguard User Guide



Hardware Description VMETRO
Ethernet Connector

Connection for Ethernet cable (10/100 Mbit - autodetect).

LAN LEDs

Indicates activity on the Ethernet connection. The green LED indicates a link has been 
established; the amber LED indicates send/receive activity over the connection.

Trigger Output

External Trigger output and ground pin labelled “VME Trg”.

External Inputs

There are 16 inputs available which are marked E0-E15. These correspond to the Ext[15:0] 
in the Analyzer Setup and Trace Display windows. 

The external inputs are used by connecting a thin probe wire (“Patch Cords“) from the 
external input pin (E0 for example) to the signal of interest. All of the external inputs can be 
added to the Trace Display via the Analyzer Setup screen and inserting the Ext fields.(See 
“Manipulating Field Columns” on page 54)

“Patch chords” with test clips are included with the Vanguard. Additional patch cords and 
test clips may be purchased from VMETRO.

External Inputs 1 to 7

These inputs are marked E1 to E7 and there are two ground pins marked G.

External Inputs 8 to 15

These inputs are marked E8 to E15 and there are two ground pins marked G.

Temperature Input

Used for measuring system temperature. The 2 pins marked Temp- and Temp+ are used with 
the supplied External Temperature Probe.

USB Mini-B port

For communication via USB cable.
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2.3 Exerciser 

The optional Exerciser module offers a programmable VMEbus Master, Target and System 
controller.

The Exerciser is supplied as a small circuit board to be mounted onto the VME carrier board.

FIGURE 2-2. 
Vanguard VME 
Exerciser 
module

Exerciser DIP switch settings

Installing the Exerciser Module

If the Exerciser is purchased seperately from the Vanguard VME carrier board use these 
instructions to mount the Exerciser module onto the VME carrier board.

1. Place the Vanguard VME board on a surface with controlled static characteristics.
2. Remove the Exerciser module from its anti-static bag.
3. Locate the three connectors on the bottom of the Exerciser module and line them up with the 

three connectors shown in Figure 2-1.
4. Firmly but gently, press the Exerciser into the connectors on the carrier board.

SW1 Not In Use (Default Off)

SW2 Not In Use (Default Off)

SW3 On: SYSRES* and SYSFAIL* are disabled at power-up.
Off: SYSRES* and SYSFAIL* are enabled (Default)

SW4 On: Auto System Controller is enabled. The Vanguard VME Exerciser will act as system 
controller as long as BG3IN is low at power-up. However, if another device drives BG3IN high 
then the Vanguard VME Exerciser will not act as system controller (Default).
Off: The Vanguard VME Exerciser will not act as system controller.

Note – Static electricity can permanently damage your Vanguard. Prevent 
electrostatic damage by following the static electricity precautions listed in the 
Installation Guide.
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2.4 External Power

The Vanguard can also be powered from the VMETRO External Power Supply (part number 401-
EPSU) via the front panel connector. 

To change to external power, the jumpers placed in positions Z1 and Z2 must be moved to positions 
Z3 and Z4. 
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2.5 Miscellaneous Parts

External Temperature Probe

Connects to the Temperature Input pins.

If no probe is attached, the temperature readout will be unavailable.

Patch Cords

These cables are necessary for connecting the External Inputs.

50Ω BNC Coax External Trigger Output cable

To connect the external output to an oscilloscope or similar, remember to terminate the oscilloscope 
to 50Ω, to match the impedance of the cable.
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2.6 Hardware Menu

The Hardware sub menu is found under Hardware in the Tools menu.

Options

Trigger Output

• Source - Specify which Vanguard tool controls the Trigger Output.
• Polarity - Choose between an active high or an active low Trigger Output.
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Network Connection

IP Settings
• Use DHCP - Dynamic Host Configuration Protocol (DHCP) is software that 

automatically assigns IP addresses to client stations logging onto a TCP/IP network. You 
normally select this option if you are connecting the Vanguard to a network.

• Enable APIPA - If the DHCP option above is selected, then the Vangaurd will 
look for a DHCP server in order to obtain an IP address. If this server is not 
available and APIPA is enabled, then it uses APIPA to automatically configure 
itself with an IP address from the range 169.254.0.1 through 169.254.255.254. 
The Vanguard will also configure itself with a default class B subnet mask of 
255.255.0.0 and will use this self-configured IP address until a DHCP server 
becomes available.
This option is also used when a Crossover Ethernet cable is used.

• Specify an IP Address - Use this option to assign the Vanguard with a fixed IP address.

Media Settings
• Link Speed & Duplex - The Ethernet port on the Vanguard is capable of operating at 

multiple speeds and duplex settings. Setting this option to “Auto Detect” will allow the 
Vanguard to select the fastest possible connection.
You can also fix the speed and duplex setting to one of the following options should you 
be experiencing stability problems:

100Mbps - Full Duplex (100Tx FD - fastest)
100Mbps - Half Duplex (100Tx HD)
10Mbps - Full Duplex (10bT FD)
10Mbps - Half Duplex (10bT HD - slowest)
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Connectivity Settings
• Connection Port -The Vanguard accepts BusView TCP/IP connections on this port 

number. Port numbers 0 through 1023 are reserved. The default settinng is 24000 and 
does not normally need to be changed. If you connect to the Vanguard through a Firewall 
you may need to change the port number to one that is not blocked by the Firewall.

LED Display

Controls the text shown on the LED Dot Matrix Display when BusView is connected to the 
Vanguard.

• 3.3V Meter, 5V Meter and 12V Meter - Voltage is displayed as "3V2", "12V0", i.e. with 
one decimal and with a uppercase "V" as the decimal point.

• Internal/External temperature in Celsius - Temperature is displayed as "45C", "4C", i.e. 
an integer temperaure with a uppercase "C" to indicate Celsius. If no External 
Temperature Probe is connected, then "Unkn" (Unknown) is displayed.

• Internal/External temperature in Farenheit - Temperature is displayed as "45F", "4F", i.e. 
an integer temperaure with a uppercase "F" to indicate Farenhiet. If no External 
Temperature Probe is connected, then "Unkn" (Unknown) is displayed.

• Bus frequency - Frequency is displayed as "33M2", "12k7", i.e. one decimal with an 
uppercase "M" (MegaHertz) or lowercase "k" (kiloHertz) as the decimal point.
A bus frequency of 0Hz will be displayed as “NOCL”

• Bus type - "VME"
• Analyzer status - Displays one of the following strings based on the current analyzer 

state:
"Unkn" - Not configured
"AIDL" - Analyzer Idle
"ASMP" - Analyzer Sampling
"ATRG" - Analyzer Triggered
"AHLT" - Analyzer Halted
"AFUL" - Analyzer Full

• Statistics status - Displays one of the following strings based on the current statistics 
state:
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"Unkn" - Not configured
"SIDL" - Statistics Idle
"SSMP" - Statistics Sampling
"STRG" - Statistics Triggered

• Protocol checker status - Displays one of the following strings based on the current 
protocol checker state:
"Unkn" - Not configured
"PDIS" - Prot. check. Disabled
"PENA" - Prot. check. Enabled

Info

This is used for Technical Support issues. We may ask you to suply us with the information shown 
in the dialog box that this option opens. See “Technical Support” on page 243 for full information 
concerning our Technical Support services.

Change Device Name

Use this option to change the name of your Vanguard. The name is shown in the Device 
Information dialog and displayed on the LED Dot Matrix Display when the Vanguard has no 
current connection to BusView.

Selftest

This is used for Technical Support issues. We may ask you to perform this Selftest and send us the 
results. See “Technical Support” on page 243 for full information concerning our Technical Support 
services.

Reset

A dialog box opens giving you the option to reset parts of the Vanguard (Analyzer, Exerciser etc.)

Firmware Watchdog

The Firmware Watchdog is used for Technical Support issues.
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2.7 Moving the SAM

The SAM can be moved between different carrier types. For example, it can be removed from the 
Vanguard PCI carrier, and mounted onto a Vanguard VME carrier. 

Removing a SAM
5. Wear an anti-static wrist strap or follow the static electricity precautions listed in the Installation 

Guide.
6. Ensure the carrier board containing the SAM is placed on a surface with suitably controlled anti-

static properties. 
7. Lift the SAM off the carrier board by carefully rocking the SAM off from the sides that are not 

connected to the carrier board as shown:.

8. Place the SAM inside an anti-static bag

Installing a SAM
1. Wear an anti-static wrist strap or follow the static electricity precautions listed in the Installation 

Guide.
2. Ensure the carrier board in which the SAM is to be installed is  on a surface with suitably 

controlled anti-static properties. 
3. Remove the SAM from its anti-static bag and and line up the connectors with the receptors on 

the carrier board.
4. Firmly but gently press the SAM onto the carrier board. You should hear a “snap” as the 

connectors slot together.
5. Inspect the connectors to ensure that they are all seated correctly.

Note – Be careful when removing the SAM. The connectors may become damaged if they are 
forced at an angle.

SAMSAM

Carrier Board

SAM
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BusView is a Windows program designed to provide an intuitive and easy method of operating your 
Vanguard. This chapter explains the use of BusView and covers the following topics.

• Starting BusView®.
• Window Elements.
• Menus bar.
• Controls.
• Predefined Setups.
• Templates.
• Multiple BusView Sessions.
• Updating Software.
• Customizing BusView.
• Host PC.
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3.1 Starting BusView®

The following steps must be carried out before BusView is ready to run:

• Install the Vanguard Hardware.
• Install BusView.
• Establish a connection between your PC and the Vanguard via Ethernet or USB.

These steps are explained in detail in the Installation Guide.

Connection Problems

If you are having problems connecting to your Vanguard the following sections may help:

• The “Network Connection“options in the Hardware Menu described in “Hardware Description” 
section.

• The Troubleshooting section in the Installation Guide.

Using a fixed IP address

To use a fixed IP address where the Vanguard is on the same subnet as the host PC running 
BusView do the following:

1. With both the Vanguard and BusView running, connect to the Vanguard through a USB cable or 
via a network that has a DHCP server running.

2. Click on Options in the Tools, Hardware menu.
3. Select the Network Connection tab
4. Click the “Specify an IP Address” option and enter the IP address, Subnet Mask and Gateway 

information.

To use a fixed IP address where the Vanguard is not on the same subnet as the host PC running 
BusView you must also do the following:

1. Click on Hardware Connection in the Tools menu.
2. Select the Advanced tab
3. Enter the IP address and name of the Vanguard. The name is optional.
4. Click the Add button.
5. Click OK
6. Click on Hardware Connection in the Tools menu and the Vanguard should now be listed.

Disconnecting / Reconnecting

• You can disconnect from the hardware by clicking on the disconnect button  in the toolbar, 
or by selecting Hardware Disconnect from the Hardware menu.

• You can reconnect from the hardware by clicking on the reconnect button  in the toolbar, or 
by selecting Hardware Connection from the Hardware menu.
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Device Information dialog

After starting BusView, a Tip of the Day window will open, along with the Device Information 
dialog, which lists all detected devices available.

FIGURE 3-1. 
Device 
Information 
dialog

Figure 3-1 shows two IP addresses, one USB connection, and one Simulator listed.

Those devices that are already in use have greyed out check boxes and are not available. This could 
be because another instance of BusView is running and is connected to that device, or someone else 
has a connection established. See “Multiple BusView Sessions” on page 39 for more information 
on running multiple instances of BusView.

If you cannot see the device you want to connect to, click on the Rescan button. If your device is 
still not listed, See “Connection Problems” on page 30.

An IP address can be added manually to the Devices list by using the Advanced tab of the Device 
Information dialog.

FIGURE 3-2. 
Status Bar

 

BusView should now present the main work area, as shown in Figure 3-3.
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3.2 Window Elements

Figure 3-3 shows the main BusView Window.

FIGURE 3-3. 
BusView.

This area is divided into three main parts: the Workspace Window, the Status Window and the 
BusView Tools area.
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Workspace Window

The Workspace window is used to start the various tools that make up the Vanguard. For example: 
right-clicking on the Analyzer Setup folder will open a menu with the options shown in Figure 3-4:

FIGURE 3-4. 
Using the 
Workspace 
Window

Workspace Files

Workspace files have a .wsp file extension and contain:

• The Trace Run setting for all modules (Analyzer, Statistics etc).
• Trigger Output settings (Source and Polarity) found in the Options of the Hardware 

Menu.
• LED Display settings for the LED Dot Matrix Display.
• Links to all of the following files that have previously been saved in the current 

Workspace:
• Analyzer Setup
• Analyzer Trace
• Statistics Setup
• Statistics Chart
• Protocol Checker
• Exerciser
• Notepad

If any of these files have been opened but not saved, then a new file will be opened when 
this Workspace file is opened.

The Workspace can be saved to disk, and then loaded for use during another BusView 
session.

• To Open a previously saved Workspace - Click Open Workspace on the File menu and 
direct the browser to the location where you saved the Workspace file you wish to open.

• To Save the current Workspace - Click Save Workspace on the File menu and direct 
the browser to the location where you wish to save the Workspace file. Give the file a 
name and click Save.

• To Close the current Workspace - Click Close Workspace on the File menu.
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Status Window

Log. This window is a running list of all activity in the tools. Each entry is timestamped. This log 
can be saved to a file for future reference.

Current. The Current window shows the most recent activity for each tool.

Tip – If you are running an overnight system monitoring trace, you can use the log to see 
when a system error occurred.

Status Log Options

To open the Status Log Options dialog, right-click 
anywhere in the Status Window and click Options.

The following options are presented:

• Maximum number of entries allowed in the 
log limits the length of the log.

• The format of the timestamp for log entries 
can be selected.

• Recording of log entries to a file can be 
selected.

Status bar

The bottom line of the window is used to present simple messages about the status of the analyzer 
and guide the user as to which keys can be typed etc. This line will also show error messages.

FIGURE 3-5. 
Status Bar

 

Bus Mode. Either PCI, PCI-X or VME.

Keyboard Mode. OVR = Overwrite mode, INS = Insert mode.

Analyzer Status Lamp.. LED color codes:

• None: Empty trace.
• Dark green: Trace full.
• Light green: Tracer is running, but has not triggered.
• Yellow: Tracer is running and has found a trigger.
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Protocol Violation Lamp. Displays status of Protocol Checker:

• Green: No violations detected
• Red: Protocol Violation has been detected.

BusView Connection Status. Connection established between BusView and the Vanguard:

• None: No connection.
• Green: Connection established.

Tools Area

This area is where the various tools will operate from.

Menus bar

Menu bar. All main commands are shown on a menu bar at the top of the window.

Drop-down Menu. Most menu bar commands have drop-down menus attached, containing a list of 
sub-commands.

Dialog box. Some commands may open a dialog box for detailed specification of various 
parameters, while others may present a secondary drop-down menu for further selections.

Tool bar. The tool bar contains most of the commands from the menu bar displayed as icons. The 
function of each icon is displayed on the status line, when pointing at the icon with the mouse 
cursor.
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3.3 Controls

BusView can be controlled via the mouse and/or keyboard. The principles are the same as for any 
other Windows-based application.

Mouse Control

By clicking the left mouse button you can make selections on the menu bar and on the tool bar, 
switch between windows, and move around in dialog boxes and pull down menus. The right mouse 
button is also used and can bring up special menu selections.

Keyboard Control

Within dialog boxes

Undo, Copy, Cut and Paste

These are implemented the same way, and with the same control characters, as in other 
Windows-based applications, and are available both in the Edit menu, with control 
characters, and at the tool bar.

TABLE 3-1. Keys for keyboard control

←↑→↓ The cursor keys move the cursor to the desired command. Type CR [i.e. ↵], or the right 
cursor key to open the drop-down menu or dialog box. Alternatively use the Alt-<key> 
method described below.

Alt-<key> All the elements at the menu bar have one underlined character. By typing Alt-<key>, 
where <key> is the underlined character, the drop-down menu or dialog box belonging to 
the specific element is activated.

↵ selects Place the cursor, by using the cursor keys, on the wanted command and type CR to select.

Gray text Commands that cannot be executed in the current context are dimmed and are 
unavailable.

Ctrl-TAB In the same way as you change Windows-based applications with the Alt-TAB keys, the 
Ctrl-TAB keys result in switching between BusView child windows.

TABLE 3-2. Keyboard control from within dialog boxes

TAB The TAB key moves the cursor from one editable field to another.

Space Makes selections, both select and deselect.

ESC The ESC key closes an unwanted dialog box or menu.
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3.4 Predefined Setups

Busview is supplied with a number of predefined setups that can be used for common Analyzer 
tasks, and as examples to help understand the Vanguard and Busview better.

To see the selection of predefined setups, start BusView and select ‘Load Predefined Setup’ from 
the File menu.

A dialog box will appear, listring the currently available predefined setups according to the bus 
mode that BusView is in.Figure 3-6 shows a list of setups for PCI mode.

FIGURE 3-6. 
Example 
Predefined 
Setups for PCI

Each setup has a related text file that contains a description of what the setup file does and how it 
can be used. These text files have the extension .pdi (Predefined information).

Some predefined setups consist of an entire workspace, for example, loading the 
CrossPCI_Wsp.wsp will open a workspace containing an Analyzer Setup and the Protocol 
Checker as well as a text file with a brief description of the CrossPCI_Wsp setup.

Predefined setups reside in the directory: ..\Program Files\Vmetro\BusView4\Example Data\ if the 
default installation directory for BusView was used. Directories for PCI, PCI-X and VME setups 
are found here.
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3.5 Templates

Templates are used to record the settings applied to Analyzer Setups, Analyzer Traces and Statistics 
Setups. These settings are saved to a file so they can be used again.

Settings that are recorded in a template file include:

When a new document of one of the setups listed in Table 3-3 is created, Busview uses a set of 
default templates to determine the settings. When BusView is used for the first time, these default 
settings are taken from within BusView. After this, the default templates are found in the directory:

C:\Documents and Settings\<User>\Application Data\Vmetro\BusView\Templates

Saving and Loading of templates is done from the File menu. From here you can save your own 
template settings.

There is also an option to return back to Default settings which will reset all template settings to 
those used when BusView starts for the first time.

TABLE 3-3. Template settings

Analyzer Setup Analyzer Trace Statistics Setup

Fields for all Sampling Modes Sampling Mode Fields for all Sampling Modes

Fields for current sampling 
mode; both alphanumeric and 
waveform where waveform is 
available.

The Decode Option for each 
Field
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3.6 Multiple BusView Sessions

Several sessions of BusView can be run simultaneously to exercise and monitor bus traffic in 
several systems. Each session of BusView requires one Vanguard.

It is possible to create separate shortcuts for BusView to open BusView in a default configuration of 
your choice. For example, if we have one VanguardPCI and one VanguardVME available for 
connection from the same PC and we wish to open two instances of BusView, one for each 
Vanguard.

To create two separate shortcuts to BusView, one for each Vanguard.

1. Right-click anywhere on your desktop and select New, then Shortcut. This will start the Create 
Shortcut wizard.

2. In the Location text box, enter the directory in which BusView is installed followed by the argu-
ment -C and a directory in which you wish to keep separate -ini files for BusView. For example:
"C:\Program Files\Vmetro\BusView4\BusView.exe" "-CC:\Documents and Set-
tings\User\My Documents\BusView\Documents\VMEComm.ini"

3. Type in a name for the Shortcut, for example, BusViewVME.
4. Start BusView from this shortcut and in the Device Information dialog, select the Vanguard 

VME. When BusView next closes, a file called VMEComm.ini in the directory ..My Docu-
ments\BusView\Documents will be created that will be used to start BusView with a default con-
nection to the VanguardVME whenever this shortcut is used.

5. Repeat the above steps to create another shortcut called BusViewPCI for the VanguardPCI.

You can also use these shortcuts to instruct BusView to open other BusView files by default, such 
as separate Workspace Files. To do this, simply add the path and filename of the file to the Target 
line in the shortcut properties. For example, the target:
"-CC:\Documents and Settings\User\My Documents\BusView\Documents\VMEComm.ini" 
“C:\Documents and Settings\User\My Documents\BusView\Documents\VME.wsp"
will connect to the VanguardVME we stated in the above example as well as open BusView using 
the Workspace Files VME.wsp.
39Issued May 4, 2004 Vanguard User Guide



Getting Started with BusView® VMETRO
3.7 Updating Software

There are two ways to update your software:

Online Update. Requires an internet connection available on the machine that BusView is 
installed. 
Click Check for Updates in the Tools menu. This will start the InstallShield Wizard which will 
check for updates. If an update has been found follow the instructions given by the Wizard.

Download Update. Check “http://www.vmetro.com/support” for downloadable updates. Your 
current BusView version can be found by clicking About Busview in the Help menu.
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3.8 Customizing BusView

The appearance of BusView can be changed using the Customize menu. To 
access the Customize menu, right click anywhere on the Menu Bar or the 
Tools area as shown in Figure 3-3

From this menu, toolbars can be turned on and off by clicking on the name of 
the toolbar. The Customize option will open a dialog box as seen in Figure 3-7 
from where more detailed customization can be made.

Reset Customize will revert BusView to its default appearance.

Therer are two main sections for customization.

• User Interface - BusView customization which includes items such as; 
default file locations, managment of multiple instances of BusView, 
Toolbars and Shortcut Keys.

• Views - Customizaton of the appearence of the Analyzer, Exerciser, 
Protocol Checker, Statistics and Notepad functions.

FIGURE 3-7. 
Customize 
Dialog
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3.9 Host PC

Host PC operations are accessed by selecting the Host PC sub menu in the Tools menu.

System Memory Allocation

Used to reserve memory on the Host PC. Specifu the size of 
memory block you wish to reserve, and enter the start 
address.

Memory that has been allocated on the Host PC can be 
accessed by the Vanguard Exerciser.

Configuration Scan

The Scan that is performed by BusView on the Host PC will show all devices available to the Host 
PC. This is usefull for checking that the Vanguard is present in the Host PC.
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 4 State Analyzer
sued M
This section explains the use and operation of the State Analyzer functions of the Vanguard.

• Introduction
• Analyzer Setup Window
• Sampling Modes
• Event Patterns
• Single Event Mode
• Sequencer Mode
• Trace Display
• Alphanumeric Trace Display
• Trace Handling
• Voltage and Temperature Meters
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4.1 Introduction

The State Analyzer samples all bus signals at the rising edge of the bus clock, or at certain valid bus 
phases, as defined by the selected Sampling Mode. See “Sampling Modes” on page 51 for detailed 
information regarding sampling modes.

Samples of VME bus activity are passed into a circular trace buffer and are compared with user-
defined trigger patterns, so that the acquisition process stops at, or around, a moment of interest.

There are eight, user defined, event comparators that can be configured.

FIGURE 4-1. 
Block diagram 
of the State 
Analyzer

The event comparators check the samples for the following conditions:

• To find a trigger, or another action defined by the Sequencer.
• Check for a valid store condition
• To increment a counter in the sequencer
• To increment a counter required for statistics.

To use the State Analyzer, the following steps must be completed:

1. A new instance of the Analyzer is opened.
2. An appropriate Sampling Mode is chosen according to which signals on the bus are of interest.
3. Event Patterns are set in one or more Comparators.
4. A trigger condition is set to stop sampling in the trace buffer.

VANGUARD

Exerciser

State Analyzer
Protocol
Checker
Statistics

VME Bus
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4.2 Analyzer Setup Window

Window Layout

Open an Analyzer Setup Window using one of the following methods:

• Open a new Analyzer Setup File from the menu bar (File, New).
• Using the Workspace Window.
• Loading an Analyzer Setup File.

The Analyzer Setup window is then displayed.

FIGURE 4-2. 
Analyzer Setup 
Window in 
Transfer mode.

Sampling Modes. The Sampling Mode determines how the VME bus signals are sampled.

Events. There are eight user definable comparators. These are shared with the Statistics Functions; 
if you are running the user defined Event Counting real time statistics in parallel with the State 
Analyzer, then be aware that any event comparators used here will be unavailable in the Statistics 
Functions, and visa versa.

Event Patterns. This area is used to specify what signals the comparators should use when looking 
at the bus activity. The Fields shown depend on which Sampling Mode is used. Some of these are 
demultiplexed signals, and some have been grouped to facilitate easier understanding of the VME 
bus activity. Mores Fields can be inserted, See “Manipulating Field Columns” on page 54.

Trigger and Store. Using either Single Event Mode, or a sequence of events (Sequencer Mode), 
this area is used to specify what information should be stored (one or more events), and which 
event(s) to trigger on.
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Analyzer Setup Options

The Analyzer Setup Options provide certain flexibility in how the Trace is triggered, stored, and 
displayed. This dialog box appears when right clicking anywhere on the Analyzer Setup screen and 
selecting Options

FIGURE 4-3. 
Analyzer Setup 
Options 
window

Trace/Trigger Control

Trace Size

This is how much of the trace buffer is used for storing the trace. Measured in Kilo Samples, 
where one sample is 256 bits wide. The trace buffer can hold up to 2 million samples (2M 
Samples), and is 64MB in size.
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Trigger Position

The trigger position value determines where the start and end of the stored trace is. In the 
following examples, we assume the size of the trace buffer has been set to 5 K Samples.

Example a .Trigger position at 0%

When the trigger condition has occurred, the next 5000 samples are stored.

Example b Trigger at 100 %

When the trigger condition has occurred, the previous 5000 samples are stored.

Example c Trigger at 50%

When the trigger condition occurs, the previous 2500 samples, and the following 2500 
samples, are stored.

Buffer Start

Buffer End

100%

0%
Trigger

5K
Samples

Buffer Start

Buffer End

100%

0%

Trigger

5K
Samples

5K
Samples

Buffer Start

Buffer End

50%

100%

0%

Trigger
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Special Cases: Trigger condition is detected before the specified trace size is filled.

When reviewing the Trace Display, there may not be the specified number of trace lines 
listed before the trigger point. This is because the trigger has occurred, before the trace 
buffer has filled, or the Analyzer has been halted manually.

Trigger Output Mode

The Analyzer can be used to trigger the Trigger Output pin on the front panel of the 
Vanguard.

The following options are listed as radio buttons in the Analyzer Setup Options window:

• Level on Trigger - The TRIG output is active once the trigger condition occurs and stays 
active for the duration of the trace.

• Follow Trigger - The TRIG output is active once the trigger condition occurs and stays 
active until the next sample that does not meet the trigger condition.

• Follow Store - The TRIG output is active for every sample that satisfies the store condi-
tion.

Timing Mode Frequency

Frequency used in Timing Mode sampling.

50%

Buffer Start

Buffer End

100%

0%

Trigger 5K
Samples

Note – Using Follow Trigger will cause a short pulse to be generated on the TRIG output 
when the Analyzer is RUN.
48 Vanguard User Guide Issued May 4, 2004



Analyzer Setup WindowVMETRO
External Inputs

Latching is assigned to external inputs here. 

The Field Name can be changed on this menu by double clicking on the Field Name. See 
“External Inputs” on page 30 for information about the external inputs.

Trace Run 

• Run current or last active setup - The setup window which is currently active (i.e. the 

setup which is “on top” in BusView) is run. The run symbol  will move to the current 
setup.

• Ask which setup to run - This option will cause a dialog box to open, asking whch Ana-
lyzer Setup to run.

• Run Selected Setup -The Analyser Setup which has the run symbol  next it will be 
run. This can be changed by clicking on the setup you require and pressing the Select 
Setup button.

Trace Show for Timing Mode

This selects how the results of the Analyzer Setup are displayed. Alphanumeric, Waveform 
or both.
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Note

This are is used for making comments about the Analyzer Setup. These notes are saved with 
the Analyzer Setup file.
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4.3 Sampling Modes

State Mode (Synchronous)

Synchronous sampling is used for STATE analysis, and captures cycles from the target system one 
by one, so that each collected cycle forms one line in the trace buffer. This sampling mode requires 
that the sampling logic extract sampling clocks from the target bus at the correct times in order to 
store information like address, data, transfer size and status in a compact form in the trace buffer.

Timing Mode (Asynchronous)

Asynchronous sampling is used for TIMING analysis, i.e. the bus is sampled at a fixed rate that can 
be selected at fourteen different speeds as fast as 133MHz or as slow as 6.25MHz.

With a sampling rate of 133MHz the bus is sampled every 7.5ns, which is sufficient to show the 
general timing relation between signals on aVME.
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4.4 Event Patterns

Event Patterns are the user defined trigger and store conditions used by the State Analyzer when 
monitoring bus activity.

Events

VME0-VME7

The eight editable patterns are, by default, labeled VME0-VME7 

FIGURE 4-4. 
Analyzer Setup 
Screen

Each of these events can also be renamed. In Figure 4-4, VME2 has been renamed 
“MyEvent” (See “Rename” on page 56).

It is possible to define more than eight Events but only eight at a time can be used for 
triggering.

Anything

In addition, there is a fixed, non-editable event labelled “Anything”. This pattern always has 
a complete “don’t care” pattern (all ‘x’), making it suitable as an unconditional trigger 
without having to clear one of the editable events.

Patterns

The default Analyzer Setup window contains a selection of some of the more important signals and 
signal groups for the selected sampling mode. You can insert additional signals or signal groups 
(See “Manipulating Field Columns” on page 54), as well as patterns with user-defined labels (See 
“Manipulating Event Rows” on page 55).
52 Vanguard User Guide Issued May 4, 2004



Event PatternsVMETRO
Editing Event Patterns

You can fill in event patterns as binary, hexadecimal, or mnemonic values in the signal fields of any 
of the predefined event patterns except for the “Anything” event. You can also delete and insert new 
event patterns and signal fields. New event patterns can be labelled and existing ones renamed.

Editing Fields

Place the cursor in the field you want to edit, and type in a new value. The new value can 
contain digits, or a mixture of digits and don’t cares (x = don’t care). Clear the field by 
selecting Clear from the Edit menu or pressing Delete on your keuboard, and then retype the 
desired value.
Press Enter, or move to another field to finish editing.

Active low: *

Active low signals are indicated with a "*" after the signal name. (Example: AS*). This 
means that an active signal is shown as a '0' in the trace.

The NOT operator: !

The NOT operator can be used for data, addresses, and some of the other fields. The NOT 
operator is used by typing an exclamation mark <!> in front of the field.

“Don’t Care” value for Signal Fields

Typing an x into a field will set the corresponding bit(s) to don't care and means that this bit 
(signal on the bus) will be ignored when the Vanguard is looking for a trigger condition or 
store qualifier.
Fields can be set to “don’t care” by:

• Selecting Clear from the Edit menu.
• Choosing <clear> from a drop-down menu obtained when right-clicking on a field.
• Pressing the Delete key on your keyboard.

TABLE 4-1. Summary of valid characters for Event fields.

x Don’t care

0 Logic zero

1 Logic one

r Rising edge

f Falling edge

a Any edge
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A Field column can be selected by left-clicking on the name of the column.
An Event row can be selected by left-clicking on the name of the event.

If a column or row is selected, then Clear will reset all values in the column or row to “don’t 
care”.

Field Options

Some fields have a dialog box to select values (right click on the field and click Options). 
Choose the option you need from the list, or select the <clear> option to reset this field to a 
“don’t care” value.

Manipulating Field Columns
Tip – More than one Field can be selected for one operation. Hold down the Ctrl key and click on 
the desired Fields. Alternatively hold down the Shift key, and use the cursor keys to select the 
Fields.

Adding Field Columns
1. Select a Field column by clicking on its name.
2. Open the Insert Fields dialog box using one of the following 

methods:
• Click Insert from the Edit menu.
• Press the Insert key on your keyboard.
• Right-click on the Field and click Insert.

3. From the dialog box, click on the signal you want to insert, and 
click OK.

4. The field column of the new signal will appear before or after 
the column you selected in Step 1; depending on which option 
button you click in the “Insert Mode” section of the dialog box 
(Before or After).

Tip – While in the dialog box, type the first letter of the signal to be inserted and the 
cursor will move to the first signal in the list that begins with that letter.

Removing Field Columns
1. Select a Field column by clicking on its name.
2. Remove the Field column using one of the following methods:

• Click the Delete button  on the toolbar.
• Click Delete from the Edit menu
• Press Delete on your keyboard.

Clearing Field Columns
1. Select a Field column by clicking on its name.
2. Clear the Field using one of the following methods:
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• Click the Erase button  on the toolbar.
• Click Erase from the Edit menu
• Press Ctrl Delete on your keyboard.

Moving Field Columns

Field columns can be moved by clicking on its name and dragging it to another position in 
the Events window.

Manipulating Event Rows
Add an Event row

1. Select an Event row by clicking on its name.
2. Open the Insert Event dialog box using one of the 

following methods:
• Click Insert from the Edit menu.
• Press the Insert key on your keyboard.
• Right-click on an Event and click Insert.

3. Type a name and choose one of the option buttons (Before 
or After), then click the OK button

4. From the dialog box, click on the signal you want to insert, and click OK.
5. The new Event will appear above or below the row you selected; depending on which 

option button you click in the “Insert Mode” section of the dialog (Before or After).

Delete an Event row

Select the undesired event by clicking on its name and perform one of the following 
operations:

• On the toolbar, click Delete. 
• From the Edit menu, select Delete.
• Press Ctrl + Delete on your keyboard.

Clear an Event row
1. Select an Event row by clicking on its name.
2. Clear the Event row using one of the following methods:

• Click the Erase button  on the toolbar.
• Click Erase from the Edit menu
• Press Ctrl Delete on your keyboard.

Note – You can save your Field layouts by using Templates. See “Templates” on page 38 
for details.
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Rename
1. Select an Event row by clicking its name.
2. Open the Rename Event dialog box using one of the 

following methods:
• Double click the Event name.
• Right-click on an Event and click Rename.

3. Type a name and click the OK button.

Copy & Paste an Event row
1. Select an Event row by clicking on its name.

2. Click on the Copy button  or select Copy from the Edit menu.
3. Place the cursor below the event where you want to insert the copied event and click on 

the Paste button  or select Paste from the Edit menu.
Tip – Events can be copied between the Vanguard tools. For example, you can copy event defined 
in the Analyzer Setup Window, and past them in the Statistics Setup Window.

Field Properties

Right clicking anywhere on a Field and choosing “Properties” will give more information about 
that Field. On some Fields, the format in which the field is used can also be modified.

FIGURE 4-5. 
Right-click 
Field menu

Note – You can save your Event layouts by using Templates. See “Templates” on page 38 
for details.
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Address and Data Options

Range

Selecting the Range checkbox allows you to specify a 
range of values as an event pattern in the Address or 
Data fields. Using a range of addresses is useful when 
interested in a specific data structure.

Range values can also be specified by pressing ‘-’ on 
your keyboard while an address or data field is selected.

Negating the range is done by typing an exclamation mark(!).

64 Bit

Select this checkbox to enter 64 bit address and data values. Swapping between 64 and 32 
bit values can be done by pressing ‘q’ while an address or data field is selected.

Binary details

Binary details makes it possible to specify “don't care” values at the bit level. Specifying 
binary details is done by typing a left bracket “(“ in front of a hex digit in the Event Patterns 
window.

FIGURE 4-6. 
Using Field 
Properties to 
set address 
range

 

Figure 4-6 shows how the first two hexadecimal digits are expanded to the binary level, 
making it possible to have “don’t care” values at the bit level. Values containing binary 
“don’t cares” will be displayed as a “$” in the Event Patterns window, as seen in Figure 4-7.
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FIGURE 4-7. 
‘Don’t Care’ 
binary address 
range
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4.5 Single Event Mode

Single Event mode is the simplest way of using the Analyzer to trigger on an event and is more 
suitable when looking for a certain transaction to occur on the bus. Using the Single Event trigger 
will cover most of your needs.

There are three steps to setting up a Single Event trigger.

1. Choose Sampling mode
2. Configure an Event Pattern
3. Select Trigger
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4.6 Sequencer Mode

The Sequencer is a state machine that enables you to define complex triggers, store qualifiers, count 
conditions and more. The Sequencer allows event patterns to be combined sequentially using IF, 
ELSIF, ELSE statements, and the logical operators AND, OR, NOT. 

The Sequencer is suitable where it is necessary to trigger the Analyzer when:

• A certain event occurs after a series of other events
• To filter out samples of no interest
• Count a number of occurrences of an event before triggering

Notation

Parametric Keywords. Are shown in UPPER CASE letters. e.g. Transfer, Clock

Event Names. Both pre-defined and user-defined names are shown in UPPER CASE. A maximum 
of eight different event names can be used in a Sequencer program at the same time. A warning will 
be given when the ninth event is taken into use. There is no limit on how many times one event 
name can be used in event expressions in the same program. The same event may serve as trigger, 
store, and count conditions.

Operators. Are shown with Initial Caps, e.g. Store, Trigger.

Fill-in words. Are shown in lower case, e.g. in, of.

Syntax

Line Numbers. Each line in a sequncer program has a number. This number consists of a ‘state’ 
number, and a ‘line within state’ letter. The number 3.a means ‘line 1 in state 3’. Line numbers are 
generated automatically by the sequncer.

Indents. Indents are used after If, Count, Delay, Elsif and Else statements. Indents are generated 
automatically by the Sequencer.

Current state indicator. An arrow ‘=>’ indicates the current state of the Sequncer.

Note – The eight event counters are shared with the Statistics Functions. If you are currently 
using counters in the Statistics Function, those counters are unavailable in the State Analyzer and 
visa versa.

2.a: If (VME2) then
2.b: Trigger ...
3.a: Sampling ...
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Operators

A sequencer program is built from a number of operators which can be listed in two groups: 
Actions and Transitions. Transitions are used to determine which Actions are executed.

Sampling

The Sampling operator is used to specify sampling mode. The first line in the Sequencer 
program is always a Sampling line and cannot be deleted. The sampling mode is changed by 
selecting the Sampling Modes tab at the top of the Analyzer Setup Window.

A Sampling expression is implicitly valid for all subsequent states in the Sequencer 
program, until superseded by a new Sampling condition.

Store

The Store operator is used to ‘filter’ the captured samples according to the event expression 
contained within the Store operator. The second line in the Sequencer program is always a 
Store condition and cannot be deleted.

A Store expression is implicitly valid for the rest of the Sequencer program, until superseded 
by a new Store expression.

The predefined expressions ALL and NOTHING are handled seperately from the eight 
definable events, and so can be used in addition to the eight definable events.

If / Elsif / Else

If / Elsif / Else statements are used to control the branching of a Sequencer program. 
Nested Elsif statements are possible, limited only by the number of possible Event 
Expressions. Both Elsif and Else are optional after an If.

The predefined expression ANYTHING can be used as an Event expression. ANYTHING is 
handled seperately from the eight definable events, and so can be used in addition to the 
eight definable events.

TABLE 4-2. Sequencer operators.

Actions Sampling, Store, Delay, Count, Trigger, Halt

Transitions If, ElsIf, Else, Goto

Note – A sample causing a Trigger is always stored.

Note – An If .. Elsif sequence without an Else always repeats itself if none of the 
conditions are met.(Implicit goto self)
Statements like
Else
Goto Current state
can be considered as an implicit closing statement.
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If no states follow an If .. then, Trigger in the Sequencer program an implicit jump to 
a state where the prevailing store condition is repeated takes place.

This is to avoid storing both the specified store condition and the trigger condition if the 
trigger condition should occur again.

Goto

The Goto statement moves the execution of the Sequencer program to the beginning of 
another state. Goto 1 will restart the Sequencer program.

Count

Count is used to count occurrences of specific cycles/events on the target bus. If a Count 
statement is used, the Sequencer program will not advance until the specified number of 
cycles that matches the event pattern attached to the Count statement occurs.

Up to 4 Count statements can be used in a Sequencer program.

Delay

Delay will pause the Sequencer program for a time, before it is allowed to advance to the 
next state.

Delay N {ns|us|ms} then if(<Event Expression>)then

Where N is a measure of delay in units of nanoseconds (ns), microseconds(us) or 
milliseconds(ms). Up to 3 Delay statements can be used in a Sequencer program.

The delay counter can be synchronized by putting an ”If (ANYTHING) then“ before the 
first delay. The delay counter will then start to count when the first sample occurs on the bus 
after the sampling is started.

A construction like Delay ... Elsif can be used to exit a delay interval on a certain 
condition, before the delay time expires.

A sample is required after the delay time is counted down, before the Sequencer will 
proceed to the next state, otherwise, a trigger will occur.

Note – Goto cannot be used to repeat Delay statements.

Note – When coverting between units, the value will be rounded to the nearest integer of 
the new unit.
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Trigger

The Trigger operator determines where in the Sequencer program the trigger should be.

Even if multiple trigger statements exist, the Trigger Position will be kept the same 
throughout the Sequencer. Modifying one of the trigger statements will result in the same 
modification to all other trigger statements.

Halt can be used to replace “Trigger at 100% of trace” if Trigger has already been used 
with one of the other parameters.

Halt

The Halt operator causes the tracer to halt and display the trace.

Logical Operators

Elements can be combined using logical operators in Table 4-3 and the Transitions listed in 
Table 4-2 .

The use of brackets to build more complex event terms using logical operators is also 
supported.

The logical AND operator, “*”, has precedence over the OR operator, “+”. Brackets can be 
used to change the order of evaluation:

A+(B*C) = A+B*C, but (A+B)*C ≠ A+B*C

This is due to the order of evaluation.

The parenthesis around the OR expression forces the OR to be evaluated before the AND.

!(A+B)*C ≠ !A+B*C

The logical NOT operator can be used on single event names, or on sub-expressions within 
brackets. The logical NOT operator “!” is always evaluated first.

Note – The trigger sample is always stored, regardless of store conditions specified.

TABLE 4-3. Logical Operators

Symbol Logical Operator

+ OR

* AND

! NOT
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Summary of implicit Actions and Transitions

The Sequencer is a compact practical way of controlling the operation of the Analyzer. To minimize 
the need for programming, a number of implicit actions in the Sequencer exist to give desired 
results without using explicit commands:

• A Sampling expression is implicitly valid for all subsequent states in the Sequencer program, 
until superseded by a new Sampling condition.

• A Store expression is implicitly valid for all subsequent states in the Sequencer program, until 
superseded by a new Store condition.

• The sample causing a Trigger is always stored.
• If no states follow an If .. then, Trigger in the Sequencer program then an implicit jump 

to a state where the prevailing store condition is repeated takes place. This is to avoid storing 
both the specified store condition and the trigger condition, if the trigger condition occurs again 
(according to the above rule saying that trigger samples are always stored).

• An implicit Else Goto current state is always present after an If-Elsif sequence if no Else 
is specified, so that the If test will always be repeated for the next sample if none of the 
conditions were met.

• Goto next state is implicit after a then or after an Else, where next state is the state belonging to 
the next line containing an If.

Using the sequencer

Select Sequencer mode by clicking on the Sequencer tab, as shown in Figure 4-8.

FIGURE 4-8. 
Selecting the 
Sequncer tab.

 

Selecting Parameters

Parameters are selected with the left mouse button. A double-click of the left mouse button 
on a slected parameter open the Event Expression dialog box.
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FIGURE 4-9. 
Event 
Expression 
dialog box

 

Some parameters, such as the Trigger Position, use a 
drop-down menu from which to choose values.

Inserting and Deleting Statements.

Right-click on the statement line from which you wish to add a line below, and choose 
Statement Edit, then click Insert.

 

Alternatively press the Insert key on your keyboard.
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Sequencer Example

 

Using Graphical representation
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4.7 Trace Display

The data in the trace buffer is automatically displayed when the current trace is filled with samples 
or if the Analyzer has been halted manually. If halted manually, then you must press the Show 

Trace button  (Shift F9) to view what is in the trace buffer. Also note that the trace buffer might 
not be full when halted manually. The contents of the trace buffer can be viewed as an alphanumeric 
display or as waveforms.

Alphanumeric. The Alphanumeric display format is used by default.

FIGURE 4-10. 
The Trace 
Display in 
Alphanumeric 
mode

  

The alphanumeric trace list shows the samples collected in the trace buffer as a list of binary or hex 
values for each signal group. The alphanumeric trace list presentation can be selected for all 
sampling modes. Figure 4-10 shows an example of an alphanumeric trace list.
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Waveform. The waveform display format can be used to display the trace when Clock or Standard 
sampling has been used. Transfer sampling cannot be displayed in waveform format.

Trace Display Options

Time Units

Not used in VME.

Display Marker Deltas and Time Fields in Clock or Time. Display in Time will ‘round off’ 
the time increments in order to present a more readable display. The Time Units are: 
picoseconds (ps), nanoseconds (ns), microseconds (µs), milliseconds (ms), seconds (s), 
minutes (m) and hours (h).

Display Waveform Ruler in Samples (one per clock) or in Time.

Editing the Trace window

The Trace window can be edited in the same way as the Event Patterns window, both in 
alphanumeric and waveform mode. Signals can be added, removed and reorganized.
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Right click anywhere on the trace display to access the menu shown in Figure 4-11

FIGURE 4-11. 
Trace Display 
menu

Add a Signal

Select Insert from the Trace Display menu, from the Edit menu, or press the Insert key on 
your keyboard to bring up a dialog box from which you can select a signal name to add to 
the trace display.

Remove a Signal

Place the cursor on the signal name you want to delete and press Ctrl Delete. Alternatively, 

select Cut from the Edit menu or click Delete  from the Trace Display menu.

Absolute or Relative Time in the Trace Window

The trace can be displayed as absolute time from the trigger sample, relative time between 
the samples, or both. AbsTime (absolute time) is default, and is displayed as a field column 
in the Trace Display window. The RelTime (relative time) option is inserted into the Trace 
window in the same way signal fields are inserted (“Manipulating Field Columns” on 
page 54).
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Formatting Options

There are two different ways of presenting the control signals in the trace. Either as 
mnemonics such as Size, Status, and Err, or as bit patterns such as Address, and Data.

In Transfer mode, it is very convenient to display the signals with mnemonics when 
sampling only once per data cycle. 

For example, the Command field, describing the type of cycle, is much easier to read when 
using mnemonics.
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4.8 Alphanumeric Trace Display

Changing the Alphanumeric Formatting Template

Select the signal you want to change and right click to 
access the Trace Display menu. Select Decoding and 
Formatting and a dialog box opens. The top most option 
enables or disables decoding and formatting globally, i.e. it 
concerns all the signals fields. The next option enables or 
disables Decoding and Formatting the currently selected 
signal field; in this example AbsTime.

If decoding and formatting are turned off globally, it is not possible to enable the current signal 
field.

By default, global decoding and formatting is on in Standard and Transfer mode, and off in Clock 
mode.

Navigating the Trace Buffer in Alphanumeric Mode

There are three ways of moving around in the trace buffer.

• With the mouse and keyboard.
• With the Jump tools.
• With the Search tools.

Mouse and keyboard

Use the mouse and left click parts of the trace display to select a field.

The mousewheel can be used to scroll up and down through the trace buffer without moving 
any markers.

The right and left cursor keys select signal fields, and the up and down keys scroll the buffer. 
The currently selected field is underlined.

PgUp and PgDown will scroll up and down through the trace buffer using the currently 
selected marker.

Note – Some signals are fixed as mnemonics (e.g. the Size field in Transfer mode). A dialog 
box containing only the first option will appear in these cases.
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Jump Tools

The Jump tools are available both at the Jump menu and the Navigation 
Toolbar. 

First Line. Jumps to the first line in the trace.

Last Line. Jumps to the last line in the trace.

Trigger Line. Jumps to the line on which the Trigger is found.

Line/Time... Jump to a user specified line or time in the trace.

Marker-X. Jump to the X marker.

Marker-Y. Jump to the Y marker

Marker-Z. Jump to the Z marker

Next Bookmark. Jump to the next bookmark.

Previous Bookmark. Jump to the previous bookmark.

The Search tools

Search tools are selected from the Navigation menu, and the 
Navigation Toolbar

The Search commands offer powerful search and extract functions. 
Search locates a particular pattern in the trace buffer.
Extract provides a qualified presentation of samples from the trace 
buffer, so that only samples matching the specified pattern are 
displayed.

 Search and Filter Patterns. When selecting the Search tools 
for the first time, the Edit Search Pattern is the only available 
option. The Search/Filter edit window is used in the same way as the Event Patterns window 
(“Editing Event Patterns” on page 53).
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FIGURE 4-12. 
Search and 
Extract options 
menu

 

Event pattern area. This is where you define which patterns to search for.

Start From options. Specifies where in the trace searching should begin.

Direction. determines whether searching should move up or down in the trace, from the 
point specified by the Start From option.

Wrap. When a search reaches the end or beginning of the trace buffer, searching will wrap 
around if this option is selected.

Find. Find the first match

Mark All. Highlight all matching lines.

Show Matches. Display only the lines that match.

Hide Matches. Hide all lines that match.

Reset. Reset all highlighting and Show/Hide settings.

Close. Exit the Searching tool.

Load. Load a previous search pattern.

Save. Save the current search pattern. This will save the search pattern to file for retrieval 
later. The file has the extension .spf If there is more than one trace type displayed, a dialogu 
box will appear asking you to specify which one to save.

Note – Searching down is much faster than searching up.
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 Next Match. Finds the next matching sample.

 Previous Match. Finds the preceeding sample that matches the search pattern

 Next Edge. Search for the next high to low, or low to high transition of the selected signal.

 Previous Edge. Search for the previous high to low, or low to high transition of the selected 
signal.

 Next Difference. Move to the next difference between two traces when using Trace Compare.

 Previous Difference. Move to the previous difference between two traces when using Trace 
Compare.

Next Split Completion. Move to the next occurance of a Split Completion (PCI-X only).

 Previous Split Completion. Move to the previous occurance of a Split Completion (PCI-X 
only).
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4.9 Waveform Trace Display

The waveform display is provided to show the logic level of individual signals graphically as a 
function of time. This is particularly useful to show timing relations between different signals for 
hardware analysis. 

Tip – To be sure of capturing some traffic, trigger the tracer with an event where AS* is 
set to zero, because there is always traffic when AS* is active.

Navigating the Trace Buffer in Waveform Mode

There are three ways of moving around in the trace buffer.

• With the mouse and keyboard.
• With the Jump tools.
• With the Search tools.

Mouse and keyboard

The currently selected marker (X, Y or Z) will be positioned wherever a left mouse click is made on 
the trace display. Left clicking on the display will also select a signal field (underlined).

The up and down cursor keys select signal fields, and the left and right keys scroll the buffer with 
the currently selected marker. The currently selected field is underlined.

PgUp and PgDown will scroll up and down, through the trace buffer using the currently selected 
marker.

Zoom. The zoom scrollbar will expand and contract the timescale of the trace 
display.
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Jump tools

The Jump tools work the same way as in alphanumeric mode (“Jump Tools” on page 72), except for 
two additional options. These additional options are for jumping to two user-positioned markers.

Markers

Markers are convenient for marking places of interest in the trace buffer. Two markers can 
also be used to limit statistics functions to a given area, or to measure the time between two 
signal edges.

Markers are selected from the buttons X, Y, and Z on the Trace Display, and are position 
using the left mouse button.

The time between markers is also display on the Trace Display.

Bookmarks

The Bookmarks toolbar is used to define and jump to bookmarks in the Trace display.

 Bookmarks. Opens a dialog box to 
manage user defined bookmarks.

Type in a name in the Name text box and click 
Add to create a new bookmark on the currently 
selected trace line.

Using this method, it is possible to create a list 
of bookmarks to jump to. You can activate a 
window by either double-clicking on a selected 
bookmark this box, or by selecting a bookmark 
and then clicking the ‘Go to Bookmark’ button. If you select multiple bookmarks, you can 
choose Delete, or Close. Use the Ctrl or Shift button together with the mouse to select 
multiple bookmarks.

 Toggle Bookmark. Toggles between showing and hiding bookmarks in the Trace 
display.

 Clear Bookmarks. Removes all bookmarks.

 Next Bookmark. Jump to the next bookmar.

 Previous Bookmark. Jump to the previous bookmark.
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Additional Windows

Additional windows, or views of the current trace buffer, may be opened and closed when needed 
using the Workspace Window. 

The windows are numbered 1, 2 etc and are totally independent views of the same trace memory.

Search tools

The Search tools work the same way as in alphanumeric mode (“The Search tools” on page 72).
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4.10 Trace Handling

Open a new Analyzer Setup File
1. On the File menu, click New
2. In the New dialogue box, choose Analyzer Setup
3. You can give this file a name by entering a name in the Filename text box. If no name is 

given, then BusView will assign a name. Default name is AnalyzerSetup1.
4. You can choose where this file is saved by pressing the browse 

button in the Location text box.

Loading an Analyzer Setup File
1. On the File menu, click Open.
2. In the “Files of type:” list, click “Analyzer Setup Files”.
3. Browse to the directory in which your Analyzer Setup Files have been saved and choose 

the file you wish to open.

Analyzer Setup Options
• With an Analyzer Setup window active, click Options on the Tools menu.
• Alternatively, right click anywhere on the Analyzer Setup window, and select Option 

from the menu.

Navigation Toolbar

Jump Tools

The Search tools

Bookmark options

Trigger

Zoom in on Waveform

Zoom out of Waveform
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Trace Files

Trace buffer data can be saved to a file by clicking on Save As in the File menu.The file format 
contains a header with target type, sampling mode, trigger position, trigger line number etc., so that 
the file can be reviewed exactly as captured.

Save as

Click Save As from the File menu and enter a file name.

A dialog box appears where you can specify which lines you 
want to save.

The trace can be saved both as binary files and as ASCII files. 
The ASCII files can then be opened and edited in any other text 
editor, but because they have not saved all the vital information about the trace, they can not 
be opened in BusView again.

Trace File Size

The size of the trace file depends on a number of factors and we recommend having at least 
250MB free disk space.

One sample has a size of 40bytes, therefore a full trace buffer containing 2M samples may 
require around 80MB of storage space. A trace file also contains information about the 
setup, filter data and other settings required to present the data in BusView and this can 
increase the size of the trace file size.

In general, it is reasonable to expect that a full 2M Sample uncompressed trace file will 
exceed 100MB in size. A temporary file is used to hold the current trace. Trace files are 
compressed when saved to disk. 

Saving as an ASCII file will greatly increase the saved file size.
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Trace Compare

The Trace Compare functionality compares two traces line by line, and marks all lines that do not 
match with yellow in both traces. In addition the field which actually causes the mismatch is 
marked with orange. The colors for highlighting can be changed from the ‘Views,Trace’ page in the 
‘Tools,Customize’ menu.

To open the Trace Compare dialog box, click on Trace Compare from the Tools menu.

Reference Trace is the trace from which comparisons are made from, whereas Compare Trace is the 
trace on which comparisons are made to. Each of these has the following options:

Current Trace . Use the trace currently in the Vanguard trace buffer

File. Use a previously saved trace file. Click the  button to browse for the file.

Synchronizing Point. Specify from where the comparison will start from. This can be; Trigger 
Position, the start of trace or any user specified line in the trace. If one trace is longer than the other, 
all lines beyond the boundaries of the shortest trace are shaded.

Line Number. The line number ton which o synchronize on, when the ‘Synchronizing 
Point’ is set to ‘Line Number’

For each view, signals are compared as shown on the screen, and only inserted fields are compared 
against the same fields in the other trace.
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FIGURE 4-13. 
Trace Compare 
Example

The highlighting can only be turned off by closing one of the compared trace files.
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Trace Counting

Trace Counting is an operation peformed after a trace has been captured and displays a number of 
statistics.

The Trace Counting dialog box is opened by clicking on Trace Counting in the Tools menu.

From Trace Line Number. Trace Line from which counting should commence.

To Trace Line Number. Trace Line at which counting should stop.

Count only for Address Range. Count transaction only within this address range.

The “Types” shown in the Trace Counting dialog box once a trace Count has been performed, have 
the same meaning as those listed in “Pre-defined Statistics” on page 91 with one exception, the 
‘Transfer Rate’. In this case, Transfer Rate shown is for the whole bus.
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4.11 Voltage and Temperature Meters

Real time temperature and voltage readings from the Vanguard are shown in BusView by clicking 
on Voltage & Temperature in the View menu.

Temperature and Volt Meter Options

Options are available to modify which temperature and voltage reading are shown, and in what 
format they are shown.

It is also possible to enable alarms that sound when a temperature or voltage reading is outside of 
some user-defined minimum and maximum values.

The Log option will allow you to record temperature and voltage levels to a text file with the 
extension .tvf
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 5 Statistics Functions
sued M
Statistics are divided into pre-defined functions, and user-defined functions.

• Introduction
• Statistics Setup Window
• Pre-defined Statistics
• User-defined Statistics
• Hardware Counters
• Statistics Charts
• Statistics Files
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5.1 Introduction

FIGURE 5-1. 
Block diagram 
of the Statistics 
Functions

 

All statistics are measured in real-time. The Statistics Functions have over 50 hardware counters 
programmed to increment on certain bus events.

In addition, there is a dedicated counter that counts the total number of samples taken. Every time 
this counter reaches its maximum count, the counters are disabled, their values read, and then 
immediately re-enabled to resume counting while the charts are computed and displayed. 

This method ensures that only a minimal amount of bus activity is missed from the measurement 
between each update of the charts. Typically 1ms per sample when running the Statsitics Functions 
alone

The following pre-defined statistics functions are available by default:

• Event Counting
• Bus Utilization
• Transfer Rate per Bus Level
• Transfer Rate per Transfer Type
• Block Length Distribution
• Interrupt Distribution
• Interrupt Service Time Distribution
• Arbiter Latency

Input
Buffer

VANGUARD
Statistics

VME Bus

Hardware
Counters
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Statistics Setup Window

Open the Statistics Setup Window using one of the following methods:

• Open a new Statistics Setup File from the menu bar (File, New).
• Using the Workspace Window.
• Load a Statistics Setup File.

Detailed explanations of Statistics Files are found at the end of this chapter. The Statistics Setup 
window has the following sections:

FIGURE 5-2. 
Statistics Setup 
Window

 

Counter Selection. There are eight counters available for the Event Counting and Customized 
statistics function.

• One to One mode - Each counter can be associated with one event.

• Counter mode - Each counter can be associated with more than one event using boolean 
expressions.

Masks. Used to reject certain results from the statistics.

Chart Selection. Select which statistics function to view.

Note – You can save your Statistics layouts by using Templates. See “Templates” on 
page 38 for details.
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Statistics Setup Options

The Statistics Setup Options dialog provides some flexibility in how the statistics are generated. 
Open the Statistics Setup Options dialog to set the options listed below.

FIGURE 5-3. 
Statistics Setup 
Options 
Window

General

Sample Rate - Time interval between samples.

Counter Mode -

• Reset - In Reset mode the displayed value is the counter reading shown as a percentage 
of the total number of samples, i.e.:

Displayed Value = (EventCount / Total Count) * 100%

• Accumulate - In Accumulate mode, the displayed value is the cumulative sum of all 
previous counter readings shown as a percentage of the accumulated total number of 
samples, i.e.:

Displayed Value = (ΣEvent Counts / Total Counts * N) * 100%

where N is the number of updates in the session.

Selection of the Accumulate versus Reset mode is typically driven by the total number of 
samples to be observed in the measurement. Measurements made in Clock Sampling mode 
typically require the use of the Accumulate mode to yield significant results because the 
counters reach terminal count very rapidly in response to the fixed frequency of the 
sampling clock.

Bus cycle measurements made in Transfer Sampling mode may or may not require the 
Accumulate option to yield significant results.
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Bus cycle measurements are affected by two key application specific factors: The total 
number of cycle operations occurring on the back plane and the frequency at which the 
cycles occur. 

The measurement of applications consisting of less than 536870912 (512M) bus cycles may 
be accomplished within the limits of the Reset mode of operation. This mode is often quite 
sufficient to support detailed characterization of new software and firmware in an isolated 
environment. However, characterization of applications inside fully operational system 
environments typically requires use of the Accumulate mode to achieve the desired 
measurements

Bus transfer Rate  

Units to Count - Selects the unit used to display Bus Transfer Rate

• MB/s - Megabytes per second counts the data transferred. The byte count and byte 
enables are taken into account.

• MTransfers/s - MegaTransfers per second counts the number of dataphases regardless of 
size.

External Inputs

The Field Name can be changed on this menu by double clicking on the Field Name. See 
“External Inputs” on page 30 for information about the external inputs.
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Statistics Run 

• Run current or last active setup - The setup window which is currently active (i.e. the 

setup which is “on top” in BusView) is run. The run symbol  will move to the current 
setup.

• Ask which setup to run - This option will cause a dialog box to open, asking whch 
Statistics Setup to run.

• Run Selected Setup -The Statistics Setup which has the run symbol  next it will be 
run. This can be changed by clicking on the setup you require and pressing the Select 
Setup button.

Note 

• This are is used for making comments about the Statistics Setup. These notes are saved 
with the Statistics Setup file.
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5.2 Pre-defined Statistics

Bus Utilization

The Bus Utilization statistic is based on Clock sampling, and displays the following parameters 
concerning the traffic on the bus: 

Overhead. All cycles which are not; Idle, Data or Retries.

Data Single. Measures the duration of single block data transfers relative to the total time, i.e. how 
much time is spent transferring single data across the bus. 

Data Block. The Data Block column measure the duration of block data transfers relative to the 
total time, i.e. how much time is spent transferring block data across the bus. 

Retries. Number of Retry and BusError cycles on the bus relative to the total time.

Idle. Number of Idle cycles relative to the total time. It is calculated by dividing the number of 
samples with NOT (AS* OR DTACK* OR DS1* OR DS0* or BERR* OR RETRY*).

From these parameters, bus Utilization and Efficiency are calculated.

Utilization. Indicates how much the bus is being used and is calculated by dividing the number of 
Transactions, by the total number of clocks.

Efficiency. The Efficiency measures the duration of data transfers versus the duration of 
transactions, i.e. how efficient the system is transferring data. It is calculated by dividing the Data 
Total percentage by the Transactions percentage.
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Bus Utilization Meter

The Bus Utilization Meter shows real-time Bus Utilization 
and Efficiency statistics. These can run at all times as an 
active window on the screen at the same time as the Analyzer, 
Exerciser, Protocol Checker and other statistics modes.

To open the Bus Utilization Meter, select it from the View 
menu.
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Transfer Rate per Bus Level

The Transfer Rate statistics calculates the transfer rate in MTransfers/Sec and MB/Sec. Note that 
the tracer does not collect samples in the period between two traces when the collected data is being 
processed

The total-bar will always display the sum of all the Bus Levels. It is recommended to run this mode 
over some time. This will give a more representative average of the systems transfer rates.
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Transfer Rate per Transfer Type

The Transfer Rate statistics calculates the transfer rate in MTransfers/Sec and MB/Sec. Note that 
the tracer does not collect samples in the period between two traces when the collected data is being 
processed

It is recommended to run this mode over some time. This will give a more representative average of 
the systems transfer rates.
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Block Length Distribution

This groups the Block Lengths of the Transactions in order to show Block usage on the system. 

 

TABLE 5-1. Block Length Distribution explanation

Abbreviation Block length/Termination

Retry/BErr Target Retry, i.e. no data transferred

RMW Read Modify Write data transfers

Single Single Cycles, i.e. one data phase

2-7 Block length from 2 to 7

8-31 Block length from 8 to 31

32-63 Block length from 32 to 63

64-127 Block length from 64 to 127

>=128 Block length longer than or equal to 128
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Interrupt Distribution

This shows the frequency of each interrupt in order to show interrupt distribution on the system
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Interrupt Service Time Distribution

This shows the time taken for each interrupt to be serviced by the system.
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Arbiter Latency

Shows the time between BR* and BS* going active. 

The values are per Transaction.
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5.3 User-defined Statistics

Event Counting

The Event Counting statistic can be used in all sampling modes. Event Counting is useful for 
counting the occurrences of different types of cycleswith a specific AM code, like A32D64,2eVME 
etc.

Eight definable hardware counters are available to count the occurrences of eight definable events. 
Events are edited in the same way as the State Analyzer (See “Editing Event Patterns” on page 53).

Note – The Analyzer and the Statistics must be use the same sampling mode.

Note – The eight definable hardware counters are shared with the State Analyzer. If you are 
currently using counters in the State Analyzer, those counters are unavailable in the Statistics 
Functions and visa versa.
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FIGURE 5-4. 
Event 
Counting 
Statistics setup

Select the Events Counting check box in the Charts to View section to turn on event counting. The 
counters to be used are selected in the same manner. Figure 5-4 shows counters 0 to 5 in use.

One to One mode

In One to One mode, each counter is represented by one event.

Counter 0 shows that we are using the Event called 2eSST, which has its event pattern 
defined as AM=A32D64_2eSST. Counter 0 will therefore count A32D64_2eSST when the 
statistics are executed.

Counter mode

Each counter can be associated with more than one event using boolean operators. To open 
the Event Counter Equation dialog, click on the Edit button  as shown in Figure 5-5

Note – Events can be renamed, copied, and deleted in the same way as the events in the 
Analyzer Setup. (“Editing Event Patterns” on page 53).
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FIGURE 5-5. 
Edit an Event 
Counter 
Equation

FIGURE 5-6. 
Event Counter 
Equation 
dialog

Use the buttons on the Event Counter Equation dialog to build boolean equations.

Boolean Expressions

Use these buttons to build equations with counters.

 Use brackets to build more complex expressions.

 Logical OR

 Logical AND

 Logical NOT

 Erase

    Cut, Copy, Paste and Delete.
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Customized Charts

Customized charts can be made using one or more of the 
hardware counters. (See “Summary of Hardware 
Counters” on page 105 for a full list of the hardware 
counters). Click the Customize check box in the Charts 
to View window to select your customized chart to be 
run with statistics.

Adding, Deleting and Renaming Customized Charts.

Customized charts can be added, deleted and renamed by using the right click menu.

Insert a new chart

To add a new Customized Chart right click anywhere below 
the Wait States statistics function and click Insert Chart. This 
will open an Insert Chart dialog box in which you must type a 
name for the new chart.

There are two options in this dialog:

Insert Mode. Choose whether you want the new chart to be 
placed before or after the currently selected chart.

Insert Type. Choose where you wish the new chart to have 
default values, or whether the new chart should be a copy of 
the currently selected chart.

Delete a chart

To delete a customized chart, right click on the chart you wish to delete and click Delete 
Chart from the menu that appears.

Rename a Chart

To rename a chart, right click on the chart you wish to rename and click Rename Chart on 
the menu that appears. A Rename Chart dialog box will open from which you can rename 
the chart.

Note – When inserting a new Customize function using the right click menu, the mouse 
cursor must be below the Wait States function. It is not possible to insert a customized 
chart between the pre-defined statistics functions.
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Editing a Customized Chart

To edit your own chart press the edit button . This will open the Customize Statistics View as 
show in Figure 5-7.

FIGURE 5-7. 
Customize 
Statistics View

 

When the Customize Statistics View dialog is open, click the Add New button to create a new 
Display Element. By default this display element will be called NewChart1 and will use the DTB 
hardware counter.

Editing a Chart Display Element

To change the equation of the chart display element press the edit button . This will open 
the Statistics Display Element dialog shown in Figure 5-8.
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FIGURE 5-8. 
Statistics 
Display 
Element dialog

All of the counters listed can be used by themselves or together using mathematical 
expressions; making a very flexible and powerful statistics tool.

In the example shown in Figure 5-8 we have renamed the element to MyCustomizedChart 
and formed the equation:

(Retry/NoTransfers)*100

This example will display a chart showing the percentage of Retries per Transfer.

Building Equations

Use the following methods to build equations:

• Add a counter to the equation by double clicking on the counter name.
• Add a mathematical expression to the equation by clicking on the relevant button in the 

dialog, or press the relevant button on your keyboard.
• Add a number to the equation by typing the number into the Number text box and press 

the Add Number button.

Button Explanations:

  Parentheses.

    Addition, Multiplication, Subtraction and Division.

 Carat (..to the power of..).

 Backspace (delete the item immediately to the left of the cursor).

    Cut, Copy, Paste and Delete the items highlighted.
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5.4 Hardware Counters

Table 5-2 shows all counters available for use in Customized Charts with a short description. The 
description for each counter is also displayed in the Statistics Display Element dialog box. 

TABLE 5-2. Summary of Hardware Counters

Clock The Timetag and Timing sampling clock period in pico-seconds (ps).

Total Total number of clocks per statistics sample.

NoTransfers Number of address phases (falling edges of AS*), i.e. number of blocks 
including singla data.

NoEventSamples Number of samples in trace using the selected sampling mode and its options.

StatVME0 Event expression counter 0. Name specified in the counter expression.

StatVME1 Event expression counter 1. Name specified in the counter expression.

StatVME2 Event expression counter 2. Name specified in the counter expression.

StatVME3 Event expression counter 3. Name specified in the counter expression.

StatVME4 Event expression counter 4. Name specified in the counter expression.

StatVME5 Event expression counter 5. Name specified in the counter expression.

StatVME6 Event expression counter 6. Name specified in the counter expression.

StatVME7 Event expression counter 7. Name specified in the counter expression.

DTBNoHwMask Total DTB. NOTE: This counter ignores the hardware mask.

DataNoHwMask Number of clocks with data. NOTE: This counter ignores the hardware mask.

BlockDataNoHwMask Number of clocks with block data. NOTE: This counter ignores the hardware 
mask.

RetryNoHwMask Number of clocks with RETRY* (or RESP*) active. NOTE: This counter 
ignores the hardware mask.

DTB Total DTB.

Data Number of clocks with data.

BlockData Number of clocks with block data.

Retry Number of clocks with RETRY* (or RESP*) active. 

AStoDTACK Number of clocks between AS* and DTACK*

BlockLenGT128 Number of transfers with block length greater than or equal to 128 data cycles.

BlockLen32_127 Number of transfers with block length between 32 and 127 data cycles.

BlockLen8_31 Number of transfers with block length between 8 and 31 data cycles.
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BlockLen2_7 Number of transfers with block length between 2 and 7 data cycles.

BlockLenSingle Number of single data transfers.

BlockLenNull Number of transfers with no data (Retry, Suspend or Terminate).

RMW Number of transfers with RMW cycles.

SlaveSuspend Number of slave suspended transfers.

SlaveTerminate Number of slave terminated transfers.

BusError Number of bus error terminated transfers.

BusXferRate2ESST Transfer rate using 2eSST. Note: The counter ignores the Bus Level hardware 
mask.

BusXferRate2EVME Transfer rate using 2eVME. Note: The counter ignores the Bus Level 
hardware mask.

BusXferRateMBLT Transfer rate using MBLT. Note: The counter ignores the Bus Level hardware 
mask.

BusXferRateBLT Transfer rate using BLT. Note: The counter ignores the Bus Level hardware 
mask.

BusXferRateSCT Transfer rate using SCT. Note: The counter ignores the Bus Level hardware 
mask.

BusXferRateBL0 Transfer rate for Bus Level 0. Note: The counter ignores the Bus Level 
hardware mask.

BusXferRateBL1 Transfer rate for Bus Level 1. Note: The counter ignores the Bus Level 
hardware mask.

BusXferRateBL2 Transfer rate for Bus Level 2. Note: The counter ignores the Bus Level 
hardware mask.

BusXferRateBL3 Transfer rate for Bus Level 3. Note: The counter ignores the Bus Level 
hardware mask.

BusXferRateUnknown Transfer rate for unknown Bus Levels. Note: The counter ignores the Bus 
Level hardware mask.

IntacksOnIRQ1 Number of interrupt acknowledges on IRQ1.

IntacksOnIRQ2 Number of interrupt acknowledges on IRQ2.

IntacksOnIRQ3 Number of interrupt acknowledges on IRQ3.

IntacksOnIRQ4 Number of interrupt acknowledges on IRQ4.

IntacksOnIRQ5 Number of interrupt acknowledges on IRQ5.

IntacksOnIRQ6 Number of interrupt acknowledges on IRQ6.

IntacksOnIRQ7 Number of interrupt acknowledges on IRQ7.

IRQ1Clocks Number of clocks IRQ1 is active.

TABLE 5-2. Summary of Hardware Counters (Continued)
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IRQ2Clocks Number of clocks IRQ2 is active.

IRQ3Clocks Number of clocks IRQ3 is active.

IRQ4Clocks Number of clocks IRQ4 is active.

IRQ5Clocks Number of clocks IRQ5 is active.

IRQ6Clocks Number of clocks IRQ6 is active.

IRQ7Clocks Number of clocks IRQ7 is active.

BusRequest0 Number of bus requests 0.

BusRequest1 Number of bus requests 1.

BusRequest2 Number of bus requests 2.

BusRequest3 Number of bus requests 3.

BR0toGNT0 Number of clocks from bus request 0 to grant 0.

BR1toGNT1 Number of clocks from bus request 0 to grant 1.

BR2toGNT2 Number of clocks from bus request 0 to grant 2.

BR3toGNT3 Number of clocks from bus request 0 to grant 3.

NoBlocks Number of address phases with a complete block.

TABLE 5-2. Summary of Hardware Counters (Continued)
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5.5 Statistics Charts

After selecting which statistics function you wish to view and have been run, The charts will open 
and display the statistics functions in real time. 

The style of chart and how it is displayed, can be modified via the Statistics Chart Options dialog.
Double clicking and holding down the mouse button inside a chart window will allow you to move 
the camera view of the chart using the mouse.
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Chart Type

Chart Type and Display Mode

Selection of 2D and 3D charts in a variety of types is selected here.

Geometry

Proportions
• Match Proportions to Window - Chart will resize to fit inside the window
• Height/Width - Slider adjusts the height and width of the chart
• Depth/width - Slider adjusts the depth and width of the chart

View Angles
• X Angle and Y Angle Sliders - Changes the viewing angles of the chart.
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Perspective
• Adjusts the perspective view of the chart.

Maximum Scale

• Auto - sets the maximum value on the Y axis to the highest visible value in the current 
set of samples.

• Other setting vary according to the type of statistics being measured, for example; the 
Event Counting statistics measarures percentage, whilst the Transfer Rate statistic 
measures MegaBytes per second.

Axis/Grid

X Axis
• Front/Bottom - Select this to show the X axis label on the Front position (for 3D charts), 

or the Bottom position (for 2D charts).
• Back/Top - Select this to show the X axis lavel on the Back position (for 3D charts) or 

the Top position (2D charts).
• Grid - Turn on a grid for the X axis.

Note – Although these settings set a maximum value for the Y axis, if a sample exceeds the 
maximum set value, then this larger value will override this setting for as long as the larger value 
is displayed on the chart.
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Y Axis
• Front/Left - Select this to show the Y axis label on the Front position (for 3D charts), or 

the Left position (for 2D charts).
• Back/Right - Select this to show the Y axis lavel on the Back position (for 3D charts) or 

the Right position (2D charts).
• Grid - Turn on a grid for the Y axis.

Z Axis
• Grid - Turn on a grid for the Zaxis.

Miscellaneous

Visible Samples
• The number of samples to show on a chart at any one time.

Legends
• The position where chart legends should be shown.
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5.6 Statistics Files

Statistics Setup Files

Open a new Statistics Setup File
1. On the File menu, click New
2. In the New dialogue box, choose Statistics Setup
3. You can give this file a name by entering a name in the Filename text box. If no name is 

given, then BusView will assign a name. Default name is StatisticsSetup1.
4. You can choose where this file is saved, by pressing the browse 

button in the Location text box.

Load a Statistics Setup File
1. On the File menu, click Open.
2. In the “Files of type:” list, click “Statistics Setup Files”.
3. Browse to the directory in which your Statistics Setup Files have been saved and choose 

the file you wish to open.

Save a Statistics Setup File

The Statistics Setup Window must be open and selected.

1. On the File menu, click Save or press the Save button . If this is the first time you 
have saved this Setup, a Save As dialog will open.
Alternatively, click Save As on the File menu to save the file as a different name than it 
currently has.

2. Browse to the directory in which you wish to save the Statistics Setup File. The default 
name is already shown in the File Name text box and can be changed.

Statistics Setup Options dialog

Open the Statistics Setup Options dialog

• With an Statistics Setup window active, click Options on the Tools menu.
• Alternatively, right click anywhere on the Statistics Setup window, and select Option 

from the menu.
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Statistics Chart File

Display Statistics Charts

Statistics Charts are displayed by running a Statistics Setup.

Save a Statistics Chart File

There are three ways in which a statistics chart file can be saved:

• Statistics Chart Binary File - saves the chart data in a binary format for use in BusView 
only. Uses the file extension .sch

• Statistics Chart Ascii File - saves the chart data in Ascii format. This can be opened and 
viewed in a text editor such as Notepad. Notepad can be opened from Busview by right-
clicking on Notepad in the Workspace Window. Uses the file extension .sca

• Statistics Counter Ascii File - saves values of the hardware counters used to generate 
the statistics charts in an Ascii format. This can be opened and viewed in a text editor 
such as Notepad. Notepad can be opened from Busview by right-clicking on Notepad in 
the Workspace Window. Uses the file extension .sca

To save a statistics chart file:

1. The Statistics Chart Window must be open and selected.

2. On the File menu, click Save or press the Save button . If this is the first time you 
have saved this Setup, a Save As dialog will open.
Alternatively, click Save As on the File menu to save the file as a different name than it 
currently has.

3. Browse to the directory in which you wish to save the Statistics Chart File. The default 
name is already shown in the File Name text box and can be changed.

When a Statsitics File is saved; the value of every hardware counter on each sample is 
recorded. This means that when you re-open a saved Statistics File you can display any of 
the Pre-defined Statistics.

Load a pre-recorded Statistics Chart File
1. Click Open in the File menu, or right click on the Statistics Chart folder in the Workspace 

window and select Open.
2. Browse to the directory in which your Statistics Chart Files have been saved and choose 

the file you wish to open.
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Statistics Playback Control

When opening a saved Statistics Chart file, a playback dialog box will also open. If it does 
not, it can be opened by clicking Chart Play Control from the View menu.

The title displays the total number of samples available in the file and the slider is used to 
move through the recorded statistics file. The Play Control buttons have the following 
meaning:

 /  Go to the Beginning / End of the Statistics File.

 /  Step back / forward through the Statistics File by the number of samples stated 
in the Step Interval box.

 /  Step back / forward through the Statistics file by one sample.

 Play the Statistics File.

Note – A saved Statistics File contains a record of the value of every hardware counter on each 
sample.
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 6 Protocol Checker
sued M
The Protocol Checker is used to test for violations to the VME specification. This chapter explains 
the use of the Protocol Checker, and describes each violation in detail.

• Introduction
• Operation
• VME Protocol Violations

Use of the Protocol Checker requires the “VG-VP” license to have 
been purchased. See “Ordering Information” on page 241.
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6.1 Introduction

The Vanguard Protocol Checker is a parallel trigger module which recognizes violations of the 
VME bus specification in real time. If one of a specified set of violations is detected, a trigger 
signal is generated. This signal can be used to trigger the Analyzer.

FIGURE 6-1. 
The main 
blocks of the 
VANGUARD 
Protocol 
Checker.

Figure 6-1, shows the three main stages of testing for protocol violations.

1. Violation Detection
This stage looks for errors by examining every bus cycle. It has a set of rule-based trigger ele-
ments that continuously and simultaneously screen the bus lines to detect protocol violations.
The violation detection stage also automatically recognizes “instability” (i.e. changes on a line) 
on all address/data lines and main control signals, without the need to be told the correct state of 
these lines beforehand. This is essential for concurrently screening for all address and data 
stability violations in the bus cycles.
This allows the Protocol Checker to find extraneous transitions on bus signals due to meta-
stability, bus ringing and noise.

2. Violation Log
Violations are logged in the Status Window and each occurrence of a violation is time stamped.

3. Trigger Logic
On each occurrence of a bus violation, a fast trigger output (within 2 to 4 clock pulses) can be 
generated. The Protocol Checker can be configured to generate this trigger signal on the first 
occurrence or on every occurrence of the specified violation. 
This trigger signal can be used in Event Patterns to trigger the Analyzer, or be incorporated in 
counters for the Statistics Functions.
External test equipment can make use of this trigger signal via the Trigger Output.

VME Bus

Violation
Detection

Violation
Log

Trigger
Logic

VANGUARD
Protocol Checker

1 2

3

Input
Buffers
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Verification of Detected violations

The Vanguard Protocol Checker cannot be used as a complete “Definitive Bus Compliance 
Validator”, since it does not check for all possible bus specification violations.

Invisible Violations

The situation may occur that a violation is detected but investigation of the bus traffic does 
not appear to show anything wrong. This can be quite frustrating, but there is usually a 
subtle problem which warrants further investigation. Viewing the wrong bus cycles is the 
largest cause of being unable to identify a violation.

To minimize this possibility, always display the Protocol Checker output signal along with 
the relevant bus signals. The erroneous bus signals will be easier to spot, as they will be very 
closely aligned in time with the high-to-low transition of the trigger.

Generally speaking, the violation will be seen from between 2 to 4 clocks cycles before the 
assertion of the Protocol Checker output signal.

Note – While the Vanguard Protocol Checker, when properly used, is believed to be free of any 
deficiencies which could indicate false errors, an error indication should never, by itself, be used 
to implicate a vendor. All reported errors should be verified by inspecting the bus activity causing 
the error. Only on the basis of such subsequent confirmation of the existence of errors should any 
vendor be presumed to be at fault.
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6.2 Operation

The Protocol Checker Window is opened using one of the following methods:

• From the menu bar (File, New).
• Using the Workspace Window.
• By pressing the run protocol checker menu tool bar button, as shown in Figure 6-2.

FIGURE 6-2. 
The Run 
Protocol 
Checker menu 
item at the 
menu bar

.

FIGURE 6-3. 
Violations in 
“Classic” view 
and “detailed 
description” 

The layout of the Protocol Checker window can vary depending on how you wish to view the 
information. This window can be viewed in three different ways.

• Classic
• Grouped Grid
• Tree

The Protocol Checker window allows you to select any set of violations to investigate. Only those 
violations that have been selected can cause the trigger output signal to activate.

• A green lamp indicates that the corresponding violation is “on” and will be tested for.
• A dark green lamp indicates that this violation has been turned “off” and will not be tested for.
• A red lamp indicates that this violation has been detected.
118 Vanguard User Guide Issued May 4, 2004



OperationVMETRO
When using the Protocol Checker to trigger the Analyzer, it is important to start the Analyzer before 
starting the Protocol Checker. If a violation has already been detected and a trigger signal present 
when the Protocol Checker is enabled, the Analyzer will store trace data from the moment the 
Protocol Checker is started. This means that the trace data will not show the violation that caused 
the trigger.

Alternatively the “Clear on Trace Run” option can be selected from the Protocol Checker Options.

Protocol Checker Options

FIGURE 6-4. 
Procotol 
Checker 
Options

Operating Modes

Clear Modes

Automatic Clear mode:  The Protocol Checker output trigger signal will automatically 
reset one clock cycle after a violation was detected. This option is useful for triggering an 
oscilloscope, etc. No violations will be displayed. 

Manual Clear mode:  The trigger signal will remain active until reset using the Clear 
command in the Violations menu.

Clear on Trace Run:  The Protocol Checker output trigger is clearde each time a trace is 
run.

Lock Modes

Lock On First mode:  The Protocol Checker will trigger only on the first violation and 
ignore all later ones. Normally only one single violation can be trigged in this mode. 
However, several violations may show up if detected at the same time.

Accumulate mode:  The protocol checker will accumulate violations as they occur on the 
bus.
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FIGURE 6-5. 
Protocol 
Checker Run 
Control

Run Control

Using the Protocol Checker

All control of the Protocol Checker is made via the menu bar, the tool bar, the status line at the 
bottom of the window, or with shortcut keys.

FIGURE 6-6. 
Protocol 
Checker right-
click menu

Note – When screening the VME bus for violations, it may be helpful to mask some violations that 
are not important in the working context, so that the Protocol Checker will not trigger on them.
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Details. Give a brief description of the selected violation.

View. Changes the view mode of the list of violations.

• Classic View - Violations are listed as they have been in previous versions of BusView.
• Grouped Grid View - Violations are categorised into the groups: Initiator, Target, Parity 

and Warnings.
• Tree View - Violations are grouped in the same way as in Grouped Grid view, but are 

listed in tree format.

Select All. The Select All command enables all the possible violations.

Select None. The Select None command disables all possible violations.

Clear. Resets all triggered violations.

Protocol Checker Output Signal

The trigger signal PCHKtrg is visible in the trace display.

When the Protocol Checker is used together with the Analyzer (e.g. to identify which cycles caused 
a bus violation), the Protocol Checker output signal is inserted into the Event Patterns window. This 
is done by clicking on the signal you want the trigger output to be in front of, and then pressing 
Insert on you keyboard to insert signals. Select the signal name PCHKTrg. (See “Manipulating 
Field Columns” on page 54).

The PCHKTrg signal field can have the following values:

TABLE 6-1. PCHKtrg values

Symbol Value Explanation

- 1 No violation

TRIG 0 VME bus violation

x x Don’t care
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Trigger External Instruments on Violations

An oscilloscope or external logic analyzer can be triggered by the Protocol Checker in different 
ways. One way is to use the output signal available on the pin header of the Vanguard main board. 
A more convenient way is to use the front panel Trigger Output

To trigger an external instrument, use the external output pin “Trigger Output” on the front panel of 
the Vanguard.

This is done by using the trigger output command in the Utilities menu.

Note – The Protocol Checker output signal will not be asserted until 2-4 VME clocks after the 
actual violation is detected on the bus.
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6.3 VME Protocol Violations

Summary of VME protocol violations

The following classes of VME bus specification violations are detected.

Summary of detected VME protocol violations

Unstable

A[7..0] or LWORD* Unstable page 125 A[15..8] Unstable page 126

A[23..16] Unstable page 126 A[31..24] Unstable page 127

D[7..0] Unstable page 127 D[15..8] Unstable page 130

D[23..16] Unstable page 130 D[31..24] Unstable page 131

2.42 AM [5..0] Unstable page 131 2.49 WRITE* Unstable page 132

Request/Grant

BR0* Aborted page 133 3.10 BBSY* off early page 135

Multiple Grants page 134 3.6 BG[0:3]* before BBSY* off page 136

Interrupt

IRQ(7:1)* aborted page 138 4.46 IACKOUT* early page 141

4.45 IACKOUT* on early page 140

Master

3.7 BBSY* on <90ns page 142 11.12 Multiple timing (DS*) line transitions page 143

11.18 or 2eSST 3.10 page 144 11.19 or 2eSST 3.11 page 144

11.5 or 2eSST 3.19 page 145 11.6 or 2eSST 3.24 page 145

11.11 or 2eSST 3.23 page 146 11.15 or 2eSST 3.7 page 146

2eSST 3.13 in address phase 1 page 147 2eSST 3.13 in address phase 2 page 147

2eSST 3.28 page 148 2.1 Illegal Signal Combination page 148

2.17 DS0* off early page 149 2.17 DS1* off early page 150

2.20 AS* before BG page 151 2.28 DSx* before BG page 152

2.28 IACK* before BG page 153 2.28 LWORD* before BG page 154

2.28 WRITE* before BG page 155 2.31 AS* off<30ns page 156

2.35 DSx* on early page 157 2.37 DSx* off <30ns page 157
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References used in protocol violation descriptions:

[1] American National Standard for 2eSST, ANSI/VITA 1.5-2003

[2] American National Standard for VME64 Extensions, ANSI/VITA 1.1-1997

[3] American National Standard for VME64, ANSI/VITA 1-1994

2.39 DSx* skew page 159 2.44 AS* off early page 161

2.43 IACK*, AM off early page 160 2.45 AS* on <30ns page 162

2.69 VME64 Address error page 163 2.96 Signals illegaly changed when RETRY* active page 163

5.1 Power Monitors timing error page 164 5V voltage low page 164

Warnings

Hidden Grants page 165 Reserved AM code used page 166

Reserved XAM code used page 166
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A[7..0] or LWORD* Unstable
This violation is triggered when a change is detected on address lines A(7:1) or LWORD* during an interval 
where these lines should be stable. To verify this error, the following signals must be inspected : A(7:1), 
LWORD*, AS* and DTACK*.

In 64-bit data (D64) block cycles, during the data transfer phase, the 31 address lines plus LWORD* (as well as 
the data lines) contain data information, and therefore must be seen as stable at the same times as data lines 
(D31:00) are required to be stable. In other words, during the data transfer portions of a D64 write cycle data must 
be stable before the start of the data strobes, and must be held stable by the master until each falling edge of 
DTACK*. During the data transfer portions of a D64 read cycle data must be stable prior to 25 ns after each 
falling edge of DTACK*, and must be held stable until each set of data strobes are rescinded. During the data 
transfer phase of D64 cycles, lines A(7:1) and LWORD* carry data bits D(39:32) (BYTE(3)).

The following diagram illustrates the key signals present during a normal VMEbus cycle, and shows the time 
period during which address lines A(7:1) and LWORD* are required to be stable. (LWORD* is not explicitly 
shown in the diagram, but has the same requirements as A(7:1).

Conditions which could cause violation of this rule :
1. Design error in a bus master, in which address is not set up sufficiently in advance of the assertion of AS* or 

so that address does not remain until DTACK* is detected.
2. Design error in bus arbitration in one or more masters, such that two or more masters take control of the bus 

simultaneously. This condition is most common in systems in which overlapped arbitration (early release of 
BBSY*) is employed, due to slightly increased opportunity for design error.

AS*

DTACK*

A(7:1)

Stability required

Stability required

Vanguard requirements for A(7:1)

VMEbus specification requirements for A(7:1)

10 ns min

STABILITY REQUIREMENTS FOR A(7:1)
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A[15..8] Unstable
The "A(15:8) unstable" violation is triggered when a change is detected on address lines A(15:8) during an 
interval where these lines should be stable. Stability is checked during all cycles except interrupt acknowledge 
VMEbus cycles, as these cycles do not use lines A(15:8). During the data transfer phase of D64 cycles these lines 
are checked for stability, as lines A(15:8) carry data bits D(47:40) (BYTE(2)).

A[23..16] Unstable
The "A(23:16) unstable" violation is triggered when a change is detected on address lines A(23:16) during an 
interval where these lines should be stable. Stability is only checked during cycles in which "standard" or 
"extended" addressing is specified by the address modifiers, as short address and interrupt acknowledge cycles do 
not use lines A(23:16). During the data transfer phase of D64 cycles these lines are checked for stability, as lines 
A(23:16) carry data bits D(55:48) (BYTE(1)).
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A[31..24] Unstable
The "A(31:24) unstable" violation is triggered when a change is detected on address lines A(31:24) during an 
interval where these lines should be stable. Stability is only checked during "extended" addressing cycles as 
specified by the address modifiers, as other cycles do not use lines A(31:24). During the data transfer phase of 
D64 cycles these lines are checked for stability, as lines A(31:24) carry data bits D(63:56) (BYTE(0)).

D[7..0] Unstable
Triggered when a change is detected on data lines D(7:0) during an interval where these lines should be stable. 
The conditions under which they are checked for stability depend upon the type of bus cycle in progress. Each 
type of cycle is discussed separately below. To verify this error, the following signals must be inspected : D(7:0), 
DS0*, DTACK* and WRITE*.
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D(7:0) unstable during VMEbus read cycle

The following diagram illustrates the key signals present during a normal VMEbus read cycle, and shows the time 
period during which data lines D(7:0) are required to be stable.

Conditions which could cause violation of this rule :
1. Memory board or other slave asserts DTACK* before it is supplying valid data.
2. Design error in slave, in which data is not latched and therefore does not remain stable and valid even after 

addresses go away and until data strobe DS0* is rescinded.
3. Design error in slave, in which a board selects itself using address strobe (AS*) only. In this way the slave may 

be falsely responding to a bus cycle when it is really not being addressed. This will result in two slaves 
responding to the same bus cycle.

4. Design error in master, in which the data transceivers of a master are illegally changed in directions after 
DTACK*, and consequently "fight" with the buffers of slave boards.

D[7..0] Unstable (Continued)

WRITE*

DS0*

DTACK*

D(7:0)

VMEbus specification requirements for D(7:0) Stability required

Stability required

25 ns max

VanguardVME requirements for D(7:0)
25 ns max

STABILITY REQUIREMENTS FOR D(7:0)
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D(7:0) unstable during VMEbus write cycle

The following diagram illustrates the key signals present during a normal VMEbus write cycle, and shows the 
time period during which data lines D(7:0) are required to be stable.

Conditions which could cause violation of this rule :
1. Design error in a bus master, in which data is not set up sufficiently in advance of the assertion of DS0*, or so 

that data does not remain until DTACK* is detected.
2. Design error in bus arbitration in one or more masters, resulting in two or more masters taking control of the 

bus simultaneously. This condition is most common in systems in which overlapped arbitration (early release 
of BBSY*) is employed, due to increased opportunity for design error.

D(7:0) unstable during address phase of A64/A40 cycles

In 64-bit address (A64) cycles the 32 data lines (as well as the address lines) contain address information, and 
therefore must be seen as stable from the time 10 ns before AS* is asserted until the first falling edge of DTACK*, 
BERR* or RETRY*. During the address phase of A64 or A40 cycles, lines D(7:0) carry address bits A(39:32). 
The Vanguard checks all applicable lines for stability, and at times is checking all 64 address and data lines 
simultaneously.

D[7..0] Unstable (Continued)

WRITE*

DS0*

DTACK*

D(7:0)

VMEbus specification requirements for D(7:0)

Vanguard requirements for D(7:0) Stability required

Stability required

10 ns min

STABILITY REQUIREMENTS FOR D(7:0)
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D[15..8] Unstable
The "D(15:8) unstable" violation is triggered when a change is detected on data lines D(15:8) during an interval 
where these lines should be stable. The conditions for stability are essentially the same as for "D(7:0) unstable" 
above, but with DS1* substituted for DS0* in the above diagram. During the address phase of A64 cycles, lines 
D(15:8) carry address bits A(47:40). During A40 cycles, lines D(15:8) carry address bits A(31:24).

D[23..16] Unstable
The "D(23:16) unstable" violation is triggered when a change is detected on data lines D(23:16) during an interval 
where these lines should be stable. The conditions for stability are essentially the same as for "D(7:0) unstable". 
Stability is only checked for D(23:16) during longword cycles and unaligned 2-byte and 3-byte cycles. During the 
address phase of A64 cycles, lines D(23:16) carry address bits A(55:48).
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D[31..24] Unstable
The "D(31:24) unstable" violation is triggered when a change is detected on data lines D(31:24) during an interval 
where these lines should be stable. The conditions for stability are essentially the same as for "D(15:8) unstable". 
Stability is only checked for D(31:24) during longword cycles and left-shifted unaligned 3-byte cycles. During 
the address phase of A64 cycles, lines D(31:24) carry address bits A(63:56).

2.42 AM [5..0] Unstable
During all data transfer cycles, the master must maintain a valid AM code and ensure that IACK* stays high until 
it detects the last falling edge on DTACK* or BERR*, rule 2.42 [3, page 86]. An error will be reported if the AM 
code or IACK* is unstable from the time AS* is asserted until DTACK* or BERR* is asserted.
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2.49 WRITE* Unstable
Once a master has driven DSA* low, it must not change the level of WRITE* until DSB* is high, rule 2.49 [3, 
page 87]. WRITE* will be tested for stability from the falling edge of DSA* until the rising edge of DSB*. If the 
signal changes polarity during that interval, an error is reported.

To verify this error, the following signals must be inspected : WRITE*, DS0*, DS1* and DTACK*.

The following diagram illustrates the key signals present during a normal VMEbus write cycle, and shows the 
time period during which WRITE* is required to be stable.

Note that DSA* and DSB* refer, respectively, to the first and last transition of data strobes DS0* and DS1*.

WRITE*

DSA*

DSB*

DTACK*

Stability required

Stability required

10 ns min

Vanguard requirements for WRITE*

VMEbus specification requirements for WRITE*

STABILITY REQUIREMENTS FOR WRITE*
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BR0* Aborted
BR1*, BR2*, BR3* are the same as "BR0* aborted" violation, but pertains to BR1*/BG1*, BR2*/BG2* and 
BR3*/BG3* instead of BG0*/BG0*.

The "BR0* aborted" violation is triggered when bus request BR0* is prematurely aborted (rescinded) before 
BG0* or BBSY* occurs. To verify this error, the following signals must be inspected : BR0*, BG0* and BBSY*. 
If using an oscilloscope or external logic analyzer, then BG0* must be measured directly at the Vanguard slot. The 
following diagram illustrates normal operation as well as an error condition.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.

In State mode the clock will run at 133 MHz. In Timing mode the clock frequency will depend on settings made 
in BusView.

Conditions which could cause this error:
1. Design error in a bus requester, in which a request is made and then aborted.
2. Bus noise (usually due to ringing or ground bounce) on the bus request line, which causes it to momentarily go 

inactive (high).

BR0*

BG0*

BBSY*

/TRIG

Error : BR0* released before BG0* or BBSY* asserted

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

BR0*

BG0*

BBSY*

Normal : BR0* held active until BG0* asserted

NORMAL OPERATION EXAMPLE
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Multiple Grants
The "Multiple grants" violation is triggered when more than one bus grant BG(3:0)* occurs at the same time. The 
VMEbus specification requires that only one grant ever occurs at any time. To verify this error, the following 
signals must be inspected : BG(3:0)*.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
not passing a grant down the daisy chain.

Conditions which could cause this error:
1. Design error in which the bus arbiter simultaneously generates grants at two or more levels.
2. Design error in bus grant daisy chain circuitry in a master which resides to the left of the Vanguard, where the 

master produces a BGxOUT* signal even when no BGxIN* is issued to it.
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3.10 BBSY* off early
The "Rule 3.10 BBSY* off early" violation is triggered when a requester rescinds BBSY* before the bus grant 
goes high. The VMEbus specification requires that BBSY* be held active until the grant which led to BBSY* is 
rescinded. To verify this error, the following signals must be inspected : BG(3:0)* and BBSY*. If using an 
oscilloscope or external logic analyzer, then BG(3:0)* must be measured directly at the Vanguard slot.

The following diagram illustrates normal operation as well as an error condition.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a grant down the daisy chain.

BR3*

BR2*

BG3*

BG2*

BBSY*

NORMAL OPERATION EXAMPLE

Normal : BBSY* held active until BG3* deasserted

Normal : BBSY* held active until BG2* deasserted

BR3*

BR2*

BG3*

BG2*

BBSY*

Normal : BBSY* held active until BG3* deasserted

Error : BBSY* released before BG2* deasserted

ABNORMAL OPERATION EXAMPLE
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3.6 BG[0:3]* before BBSY* off
The "Rule 3.6 : Bus grant before BBSY* off" violation is triggered when the bus is granted to a new master 
(BGx* goes active) before BBSY* goes away. A new bus grant BGx* is prohibited from being issued until 
BBSY* from the previous master goes away, as illustrated below. To verify this error, the following signals must 
be inspected : BG(3:0)* and BBSY*. If using an oscilloscope or external logic analyzer, then BG(3:0)* must be 
measured directly at the Vanguard slot.
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The following diagram illustrates normal operation, an error condition, and an example of noise detected as this 
error.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.

3.6 BG[0:3]* before BBSY* off (Continued)

BR3*

BR2*

BG3*

BG2*

BBSY*

Normal : BG2* asserted when BBSY* inactiv e

Normal : BG3* asserted when BBSY* inactiv e

NORMAL OPERATION EXAMPLE

BR3*

BR2*

BG3*

BG2*

BBSY*

/TRIG

A BNORMA L OPERA TION EXA MPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

Error : BG2* asserted when BBSY* activ e

Normal : BG3* asserted when BBSY* inactiv e

BG3*

BBSY*

/TRIG

Sev ere ringing during deassertion of  BG3* caused
VBAT to trigger as if  a rule 3.6 error had occured

NOISE DETECTED A S RULE 3.6 ERROR

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
137Issued May 4, 2004 Vanguard User Guide



Protocol Checker VMETRO
IRQ(7:1)* aborted
The "IRQ(7:1)* aborted" violation is triggered when one of the interrupt lines IRQ(7:1)* is aborted before the 
appropriate interrupt acknowledge cycle is started. Rules 4.5 and 4.6 of the VMEbus specification prohibit an 
interrupter from releasing an interrupt request line IRQx* before it detects a falling edge on DSA* during the 
interrupt acknowledge cycle which acknowledges its interrupt. To verify this error, the following signals must be 
inspected : DS0*, DS1*, IRQ(7:1)*, IACK*, A(3:1) and DTACK*.

The following diagram illustrates normal operation as well as an error condition.

IRQ7*

IACK*

A(3:1)

DSA*

DTACK*

Normal : IRQ7* held active until DSA* asserted

NORMAL OPERATION EXAMPLE

IRQ7*

IACK*

A(3:1)

DSA*

DTACK*

/TRIG

Error : IRQ7* deasserted before DSA* asserted

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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4.41 IACKOUT* lingers
The "Rule 4.41 : IACKOUT* lingers" violation is triggered when, at the end of an interrupt acknowledge cycle, 
the IACKOUT* line of a master was not driven high within 40 ns after AS* was driven high. To verify this error, 
the following signals must be inspected : AS*, IACK* and IACKOUT*. If using an oscilloscope or external logic 
analyzer, then IACKOUT* must be measured directly at the Vanguard slot.

The following diagram illustrates normal operation as well as an error condition.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than the failing board, 
because IACKIN*/IACKOUT* is a daisy-chain line.

AS*

IACKOUT*

VMEbus specification requirements

VBAT requirements

NORMAL OPERATION EXAMPLE

30 ns max

40 ns max

AS*

IACKOUT*

/TRIG

40 ns

Error : IACKOUT* remains asserted more than 40 ns after AS* deasserted

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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4.45 IACKOUT* on early
The "Rule 4.45 : IACKIN* on early" violation is triggered when IACKIN* goes low before DTACK* and 
BERR* have gone high (been rescinded after the previous cycle), or if IACKIN* goes low after DTACK* is 
driven low during the present cycle. To verify this error the following signals must be inspected : DTACK*, 
BERR*, AS* and IACKIN*. If using an oscilloscope or external logic analyzer, then IACKIN* must be measured 
directly at the Vanguard slot.

The following diagram illustrates normal operation, two different error conditions, and an example of noise 
detected as this error.

DTACK*

IACKIN*

/TRIG

Error : IACKIN* asserted bef ore DTACK* deasserted

ABNORMAL OPERATION - CASE 1

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

DTACK*

IACKIN*

/TRIG

Error : IACKIN* asserted af ter DTACK* asserted

ABNORMAL OPERATION - CASE 2

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

DTACK*

IACKIN*

/TRIG

Sev ere ringing during deassertion of  IACKIN* caused
Vanguard to trigger as if  a rule 4.45 error had occured

NOISE DETECTED A S RULE 4.45 ERROR

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

DTACK*

IACKIN*

Normal : IACKIN* asserted when DTACK* is inactive

NORMAL OPERATION EXAMPLE
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4.46 IACKOUT* early
The "Rule 4.46 : IACKOUT* early" violation is triggered when the IACKOUT* line of the board to the left of the 
Vanguard is driven low less than 30 ns after the falling edge of AS*, when the IACKIN* line is low when the 
IACK daisy-chain driver detects a falling edge on DSA*. To verify this error, the following signals must be 
inspected : AS*, DS0*, DS1*, IACKIN* and IACKOUT*. If using an oscilloscope or external logic analyzer, 
then IACKOUT* must be measured at the slot preceding the Vanguard slot.

The following diagram illustrates normal operation as well as an error condition.

Conditions which could cause this error:
1. Design error in which IACKOUT* is issued by an interrupter in direct response to IACKIN* without qualify-

ing the output with AS* and DS*, and without providing enough delay for settling of the IACK daisy-chain. 
This error is made frequently, since this rule was not present in early VMEbus specifications.

Condition which would cause a false error, when no error actually exists :
1. The Vanguard is installed in a slot to the left of where the first interrupter in the system is located. Since 

IACKIN* is derived from IACK* at slot 1, it will necessarily violate this rule prior to travelling through an 
interrupter. For this reason this error should be checked out and then ignored if the above case is true.

IACKIN*

DSA*

IACKOUT*

40 ns min

30 ns min

VMEbus specification requirements

Vanguard requirements

NORMAL OPERATION EXAMPLE

IACKIN*

DSA*

IACKOUT*

/TRIG

Error : IACKOUT* asserted less than 30 ns
after DSA* asserted

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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3.7 BBSY* on <90ns
The "Rule 3.7 : BBSY* on < 90 ns" violation is triggered when BBSY* is active for too short a time (< 90 ns). To 
verify this error, the following signals must be inspected : BBSY*.

The following diagram illustrates normal operation, an error condition, and two examples of noise detected as this 
error.

BBSY*

90 ns min

90 ns min

NORMAL OPERATION EXAMPLE

VMEbus specification requirements

Vanguard requirements

BBSY*

/TRIG

Error : BBSY* remains active
for less than 80 ns

90 ns

ABNORMAL OPERATION EXAMPLE

20-80 ns

BBSY*

/TRIG

Temporary interruption of BBSY* caused Vanguard
to trigger as if a rule 3.7 error had occured

NOISE DETECTED AS RULE 3.7 ERROR

BBSY*

/TRIG

< 90 ns

Severe ringing during deassertion of BBSY* caused
VBAT to trigger as if a rule 3.7 error had occured

NOISE DETECTED AS RULE 3.7 ERROR

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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Conditions which could cause this error:

1. Design error in an "overlapped arbitration" bus master, in which BBSY* is rescinded immediately after AS* is 
asserted, without giving due consideration to ensuring that BBSY* has been held active for long enough.

2. Bus noise, usually due to ground bounce from simultaneous assertion of 31 address lines (plus 32 data lines in 
case of a write cycle) which causes BBSY* to go momentarily inactive (high).

3. Bus noise (usually aggravated by the slow rise time of this open collector line) in which BBSY* is asserted, 
then rescinded, and noise causes it to momentarily go active (low) again. This situation is common, due to the 
slow and gradual de-assertion of BBSY*, due to the fact that BBSY* is normally an open collector output.

3.7 BBSY* on <90ns (Continued)

11.12 Multiple timing (DS*) line transitions
In 2eVME protocols only one timing (DS*) line shall transition in any one bus cycle except when the transaction 
is ended, VME64x rule 11.12 [2, page 61]. Error 11.12 from the protocol checker indicates that this rule is broken.
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11.18 or 2eSST 3.10
According to VMEx rule 11.18 [2, page 61] and 2eSST rule 3.10 [1, page 18], BERR* shall only be asserted on 
the first or third address phase instead of toggling DTACK*. If is asserted during address phase 2, an error is 
reported.

11.19 or 2eSST 3.11
DTACK* shall be the only valid response during address phase two, 2eVME rule 11.19 [2, page 61] and 2eSST 
rule 3.11 [1, 18]. Since DTACK* is the only valid response in address phase two, DTACK* must be high at the 
end of address phase two. If this is not the case, an error is reported.
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11.5 or 2eSST 3.19
In the second address phase, the cycle count is transferred on A[15:8]. The cycle count is the number of data beats 
to be transferred divided by two. As the maximum number of data beats is 256, the maximum allowed cycle count 
is 128. For a 2eSST transfer, the protocol checker will issue an error if the cycle count is greater than 128. This is 
a violation of 2eSST rule 3.19 [1, page 20]. For 2eVME transfers, the protocol checker will issue an error if the 
cycle count is greater than 128, but not equal to 255. This is a violation of VME64x rule 11.15 [2, page 60]. A 
cycle count of 255 indicates that block length is unknown and slave termination expected, VME64x rule 11.10 [2, 
page 60].

11.6 or 2eSST 3.24
During 2eSST transfers the transmitter shall not cross any 2048 byte boundary, rule 3.23 [1, page 22]. 6U 2eVME 
transfers have the same requirement, but 3U 2eVME transfers must not cross any 1024 byte boundary, rule 11.6 
[2, page 60]. The protocol checker stores the start address, counts the number of bytes transferred and reports any 
violation to these rules.
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11.11 or 2eSST 3.23
2eSST rule 3.23 [1, page 22] and VME64x rule 11.11 [1, page 60] specify that the transmitter shall not attempt to 
transfer more data during the address phase than is specified by the cycle count. If such an attempt is done, a error 
will be indicated by the protocol checker.

11.15 or 2eSST 3.7
For both 2eSST and 2eVME transfers it is required that the starting address is aligned on 16-byte boundaries, 
2eSST rule 3.7 [1, page 18] and VME64x rule 11.15 [2, page 61]. This requirement is equivalent to requiring the 
four least significant bits of A to be zero during address phase 2. An error is reported if they are not equal to zero.
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2eSST 3.13 in address phase 1
RETRY*/RESP* must not be asserted during address phase one or two of 2eSST transfers, rule 3.13 [1, page 18]. 
If the rule is violated, the protocol checker will report the error and in which address phase the error occurred.

2eSST 3.13 in address phase 2
RETRY*/RESP* must not be asserted during address phase one or two of 2eSST transfers, rule 3.13 [1, page 18]. 
If the rule is violated, the protocol checker will report the error and in which address phase the error occurred.
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2eSST 3.28
For 2eSST transfers, rule 3.28 and 3.29 [1, pp 22-23] states that the master shall terminate the transfer by ending 
the data transfer on an even data beat. If the master attempts to transfer using an odd number of beats, an error will 
be reported.

2.1 Illegal Signal Combination
The "Rule 2.1 : Illegal signal combination" violation is triggered when either of the following illegal 
combinations occur :

DS1*=high, DS0*=low, A01=high, LWORD*=low
or
DS1*=low, DS0*=high, A01=high, LWORD*=low

To verify this error, the following signals must be inspected : DS0*, DS1*, A01, LWORD* and DTACK*.
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2.17 DS0* off early
The "Rule 2.17 : DSx* off early" violation is triggered when DS0* or DS1* is rescinded before DTACK* or 
BERR* is received. To verify this error, the following signals must be inspected : DS0*, DS1*, DTACK* and 
BERR*.

The following diagram illustrates normal operation, an error condition, and a situation where noise is detected as 
this error.

Conditions which could cause this error:

1. Design error in a bus master, in which one or both data strobes are rescinded before DTACK* is received.
2. Bus noise (usually due to ringing or ground bounce) which causes one of the data strobes to go momentarily 

inactive (high).
3. Wrong timeout settings. If, for example, a CPU board (master) has a local bus timeout shorter than the VME-

bus timeout and attempts to access a non-existing VME address, a timeout on the local bus may illegally ter-
minate the cycle before BERR* is received on VMEbus.

DS0* or DS1*

DTACK* or BERR*

NORMAL OPERATION EXAMPLE

Normal : DS0* (and DS1*) held active until DTACK* (or BERR*) asserted

DS0* or DS1*

DTACK* or BERR*

/TRIG

ABNORMAL OPERATION EXAMPLE

Error : DS0* (or DS1*) deasserted before
DTACK* (or BERR*) asserted

DS0* or DS1*

DTACK* or BERR*

/TRIG

NOISE DETECTED AS RULE 2.17 ERROR

Temporary interruption of DS0* (or DS1*) caused
Vanguard to trigger as if a rule 2.17 error had occured

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.17 DS1* off early
The "Rule 2.17 : DSx* off early" violation is triggered when DS0* or DS1* is rescinded before DTACK* or 
BERR* is received. To verify this error, the following signals must be inspected : DS0*, DS1*, DTACK* and 
BERR*.

The following diagram illustrates normal operation, an error condition, and a situation where noise is detected as 
this error.

Conditions which could cause this error:

1. Design error in a bus master, in which one or both data strobes are rescinded before DTACK* is received.
2. Bus noise (usually due to ringing or ground bounce) which causes one of the data strobes to go momentarily 

inactive (high).
3. Wrong timeout settings. If, for example, a CPU board (master) has a local bus timeout shorter than the VME-

bus timeout and attempts to access a non-existing VME address, a timeout on the local bus may illegally ter-
minate the cycle before BERR* is received on VMEbus.

DS0* or DS1*

DTACK* or BERR*

NORMAL OPERATION EXAMPLE

Normal : DS0* (and DS1*) held active until DTACK* (or BERR*) asserted

DS0* or DS1*

DTACK* or BERR*

/TRIG

ABNORMAL OPERATION EXAMPLE

Error : DS0* (or DS1*) deasserted before
DTACK* (or BERR*) asserted

DS0* or DS1*

DTACK* or BERR*

/TRIG

NOISE DETECTED AS RULE 2.17 ERROR

Temporary interruption of DS0* (or DS1*) caused
Vanguard to trigger as if a rule 2.17 error had occured

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.20 AS* before BG
The "Rule 2.20 : AS* before bus grant" violation is triggered when AS* has been driven low before the bus has 
been properly granted to the master. No master is permitted to drive AS* (as well as other signals dealt with 
below) until it receives it's bus grant, or unless BBSY* is already active. To verify this error, the following signals 
must be inspected : BG(3:0)*, BBSY*, AS* and DTACK*. If using an oscilloscope or external logic analyzer, 
then BG(3:0)* must be measured directly at the Vanguard slot.

The following diagram illustrates normal operation as well as an error condition. (BR3* and BG3* is shown in 
the diagram, but all pairs of Bus Request and Bus Grant lines have the same requirements).

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.

BR3*

BG3*

BBSY*

AS*

Normal : AS* asserted when BBSY* active

Normal : AS* asserted when BG3* active

NORMAL OPERATION EXAMPLE

BR3*

BG3*

BBSY*

AS*

/TRIG

Error : AS* asserted before BG3* has become active

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.28 DSx* before BG
The "Rule 2.28 : DSx* before bus grant" violation is triggered when DS0* or DS1* has been driven low before 
the bus has been properly granted to the master. Operation is essentially the same as for "Rule 2.20 : AS* before 
bus grant" violation above, except that DS0* or DS1* should be substituted for AS* in the diagram. To verify this 
error, the following signals must be inspected : BG(3:0)*, BBSY*, DS0*, DS1* and DTACK*. If using an 
oscilloscope or external logic analyzer, then BG(3:0)* must be measured directly at the Vanguard slot.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.
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2.28 IACK* before BG
The "Rule 2.28 : IACK* before bus grant" violation is triggered when IACK* has been driven low before the bus 
has been properly granted to the master. Operation is essentially the same as for "Rule 2.20 : AS* before bus 
grant" violation above, except that IACK* should be substituted for AS* in the diagram. To verify this error, the 
following signals must be inspected : BG(3:0)*, BBSY*, IACK*, AS* and DTACK*. If using an oscilloscope or 
external logic analyzer, then BG(3:0)* must be measured directly at the Vanguard slot.

The following diagram illustrates normal operation as well as an error condition. (BR3* and BG3* is shown in 
the diagram, but all pairs of Bus Request and Bus Grant lines have the same requirements).

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.

BR3*

BG3*

BBSY*

IACK*

AS*

NORMAL OPERATION EXAMPLE

Normal : IACK* asserted when BG3* active

BR3*

BG3*

BBSY*

IACK*

AS*

/TRIG

Error : IACK* asserted before BG3* active

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.28 LWORD* before BG
The "Rule 2.28 : LWORD* before bus grant" violation is triggered when LWORD* has been driven low before 
the bus has been properly granted to the master. Operation is essentially the same as for "Rule 2.20 : AS* before 
bus grant" violation above, except that LWORD* should be substituted for AS* in the diagram. To verify this 
error, the following signals must be inspected : BG(3:0)*, BBSY*, LWORD*, AS* and DTACK*. If using an 
oscilloscope or external logic analyzer, then BG(3:0)* must be measured directly at the Vanguard slot.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.
154 Vanguard User Guide Issued May 4, 2004



VME Protocol ViolationsVMETRO
2.28 WRITE* before BG
The "Rule 2.28 : WRITE* before bus grant" violation is triggered when WRITE* has been driven low before the 
bus has been properly granted to the master. Operation is essentially the same as for "Rule 2.20 : AS* before bus 
grant" violation above, except that WRITE* should be substituted for AS* in the diagram. To verify this error, the 
following signals must be inspected : BG(3:0)*, BBSY*, WRITE*, AS* and DTACK*. If using an oscilloscope 
or external logic analyzer, then BG(3:0)* must be measured directly at the Vanguard slot.

Note that this violation will not be seen if the Vanguard is located at a higher slot number than a master which is 
taking over the bus and therefore does not pass a bus grant down the daisy chain.
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2.31 AS* off<30ns
The "Rule 2.31 : AS* off < 30 ns" violation is triggered when AS* is inactive for too short a time period (< 30 ns) 
between successive bus cycles. To verify this error, the following signals must be inspected : AS* and DTACK*.

The following diagram illustrates normal operation as well as an error condition.

AS*

NORMAL OPERATION EXAMPLE

New cyclePrevious cycle

30 ns min

30 ns min

VMEbus specification requirements

Vanguard requirements

AS*

/TRIG

30 ns

Error : Less than 30 ns between
successive AS* pulses

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.35 DSx* on early
The "Rule 2.35 : DSx* on early" violation is triggered when DS0* or DS1* are driven low before DTACK* and 
BERR* have gone high (been rescinded after the previous cycle). To verify this error, the following signals must 
be inspected : DS0*, DS1*, DTACK* and BERR*.

The following diagram illustrates normal operation, an error condition, and a situation where noise is detected as 
this error.

DTACK* or BERR*

DS0* or DS1*

NORMAL OPERATION EXAMPLE

Normal : DS0* (or DS1*) asserted when
DTACK* (and BERR*) inactive

DTACK* or BERR*

DS0* or DS1*

/TRIG

ABNORMAL OPERATION EXAMPLE

Error : DS0* (or DS1*) asserted when DTACK* (or BERR*) active

DTACK* or BERR*

DS0* or DS1*

/TRIG

Severe ringing during deassertion of DS0* or DS1* caused
Vanguard to trigger as if a rule 2.35 error had occured

NOISE DETECTED AS RULE 2.35 ERROR

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

2.37 DSx* off <30ns
The "Rule 2.37 : DSx* off < 30 ns" violation is triggered when DS0* or DS1* are inactive for an insufficient time 
period between successive bus cycles (< 30 ns). To verify this error, the following signals must be inspected : 
DS0*, DS1* and DTACK*.

The following diagram illustrates normal operation as well as an error condition.
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Note that DSA* and DSB* refer to the first and last transition, respectively, of data strobes DS0* and DS1*.

Note: In addition to its normal function, the "Rule 2.37 : DSx* off < 30 ns" violation may often be triggered by 
non-monotonic rising (ending) edges of DS0* or DS1*. Refer to the description of "Rule 2.39 : DSx* skew" 
violation which discussed a similar situation.

2.37 DSx* off <30ns

DSB*

DSA*

NORMAL OPERATION EXAMPLE

New cyclePrevious cycle

30 ns min

30 ns min

VMEbus specification requirements

Vanguard requirements

DSB*

DSA*

/TRIG

30 ns

Error : Less than 25 ns between
successive DSx pulses

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.39 DSx* skew
The "Rule 2.39 : DSx* skew" violation is triggered when, during cycles where both data strobes are driven low, 
there is excessive skew (> 20 ns) between the starting edges of the first and second strobe. To verify this error, the 
following signals must be inspected : DS0*, DS1* and DTACK*.

The following diagram illustrates normal operation and an error condition.

In addition to its normal function, the "Rule 2.39 : DSx* skew" violation may often be triggered by non-
monotonic rising (ending) edges of DS0* or DS1*. Such behaviour is usually the result of a slow-rising DS0* or 
DS1* waveform which dwells near the threshold region for a long time, making it susceptible to multiple 
transitions through the receiver's threshold due to any coupled noise. Slow rise time is often caused by excessive 
bus capacitance due to board having PCB traces for DS0* and DS1* that are much longer than the specified 2 
inches. Such noise is potentially serious since some slaves use the ending edges of DS0* or DS1* for 
incrementing counters etc. Multiple edges could cause trouble in that and other cases. Therefore, this alternative 
activator of this violation trigger should be investigated carefully.

DSB*

DSA*

NORMAL OPERATION EXAMPLE

New cyclePrevious cycle

30 ns min

30 ns min

VMEbus specification requirements

Vanguard requirements

DSB*

DSA*

/TRIG

30 ns

Error : Less than 25 ns between
successive DSx pulses

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
159Issued May 4, 2004 Vanguard User Guide



Protocol Checker VMETRO
2.43 IACK*, AM off early
The master must not change the levels on IACK*, A, AM or LWORD* until 30 ns after AS* is driven low, rule 
2.43 [3, page 86]. The protocol checker will only report an error if AM or IACK* changes from the time AS* is 
asserted and 30 ns thereafter, instabilities on LWORD* and A is not detected.
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2.44 AS* off early
The "Rule 2.44 : AS* off early" violation is triggered when AS* is rescinded before the last falling edge on 
DTACK*, BERR* or RETRY* occurs. To verify this error, the following signals must be investigated : AS*, 
DTACK*, BERR*, DS0* and DS1*.

The following diagram illustrates the correct timing relationship between AS* and DTACK*/BERR* for single 
transfer and block transfer, as well as an error condition. (BERR* is not explicitly shown in the diagram, but has 
the same timing requirements as DTACK*).

Conditions which could cause this error:

1. Design error in a bus master, in which AS* is rescinded before DTACK* is received.
2. Bus noise (usually due to ringing or ground bounce) which causes AS* to go momentarily inactive (high).
3. Wrong timeout settings. If, for example, a CPU board (master) has a local bus timeout shorter than the VME-

bus timeout and attempts to access a non-existing VME address, a timeout on the local bus may illegally ter-
minate the cycle before BERR* is received on VMEbus.

AS*

DTACK*

Normal : AS* held active until DTACK* asserted

NORMAL OPERATION - SINGLE TRANSFER

AS*

DTACK*

Normal : AS* held active until last assertion of DTACK*

NORMAL OPERATION - BLOCK TRANSFER

AS*

DTACK*

/TRIG

Error : AS* deasserted before last assertion of DTACK*

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.45 AS* on <30ns
The "Rule 2.45 : AS* on < 30 ns" violation is triggered when AS* is active for too short a time (< 30 ns). To 
verify this error, inspect AS*.

The following diagram illustrates normal operation, an error condition, and an example of noise detected as this 
error.

AS*

30 ns min

30 ns min

VMEbus specification requirements

Vanguard requirements

NORMAL OPERATION EXAMPLE

AS*

/TRIG

30 ns

Error : AS* remains active for less than 30 ns

ABNORMAL OPERATION EXAMPLE

AS*

/TRIG

< 30 ns

Severe ringing during deassertion of AS* caused
Vanguard to trigger as if a rule 2.45 error had occured

NOISE DETECTED AS RULE 2.45 ERROR

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz
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2.69 VME64 Address error
The "Rule 2.69 : VME64 address error" violation is triggered when A02, A01, DS1*, DS0* and LWORD* are not 
all driven low during the address phase of a 64-bit data cycle.

2.96 Signals illegaly changed when RETRY* active
A master that responds to RETRY* must not change the levels on IACK* and AM until it detects the rising edge 
of RETRY*, rule 2.96 [3, page 88]. If AM or IACK* change during the time RETRY* is low, an error is reported. 
Other properties described in rule 2.96 are not tested.
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5.1 Power Monitors timing error
The "Rule 5.1 : SYSRESET* off < 4.85 V" violation is triggered when, during power up, the SYSRESET* signal 
goes away before the +5V power lines go above 4.85 volts. The VMEbus specification requires that SYSRESET* 
be held low until 200 ms after the +5V power goes to 4.875 volts. The Vanguard is more lenient, requiring the 
+5V lines to reach at least 4.85 volts before SYSRESET* is released.

The following diagram illustrates normal operation as well as an error condition.

+5 VDC

SYSRESET*

4.85 V

Normal : SYSRESET* held active until
+5V goes above 4.85 volts

NORMAL OPERATION EXAMPLE

+5 VDC

SYSRESET*

/TRIG

Error : SYSRESET* goes inactive before
+5V goes above 4.85 volts

4.85 V

ABNORMAL OPERATION EXAMPLE

7 clocks + (5 to 35 ms)
50-85ms @ 133 MHz

5V voltage low
The "5 V supply < 4.85 V" violation is triggered when the +5V power on the bus dips below 4.85 volts. This 
trigger is capable of detecting even very brief power dropouts. This type of problem is far more common than is 
generally realized.

Conditions which could cause this error:

1. The +5V power at the power supply may be misadjusted to too low a value.
2. The wiring which supplies the +5V power between the power supply and the backplane may be too thin, 

resulting in excessive voltage drop. This problem may generally be solved by connecting remote-sense power 
supply inputs at the backplane.
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Hidden Grants
The "Grant hidden (Not error)" violation is triggered when the first error condition is detected, if the Vanguard 
was unable to fully detect errors on the bus grant daisy chain signals BG(3-0)*, because it was located to the right 
of the active master, and the daisy chain was therefore blocked.

This violation does not in itself indicate an error condition, but is a warning that one or more of the following 
error conditions may have been hidden from being detected by the Vanguard.

Multiple Grants: Rule 2.20 : AS* Before Bus Grant
BR0* Aborted: Rule 2.28 : IACK* Before Bus Grant
BR1* Aborted: Rule 2.28 : WRITE* Before Bus Grant
BR2* Aborted: Rule 2.28 : LWORD* Before Bus Grant
BR3* Aborted: Rule 2.28 : DSx* Before Bus Grant
Rule 3.6   : BG Before BBSY* Off
Rule 3.10 : BBSY* Off Early
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Reserved AM code used
This is not a violation, it is just a warning that one of the reserved AM codes in table 2-3 in the VME64 
specification [3, pp 21-22] has been used in a VME transfer that was not an interrupt acknowledge.

Reserved XAM code used
The XAM code is checked on the first falling edge of DTACK* in 2eSST and 2eVME cycles. If the code is not 
among the ones defined in the specifications for 2eSST[1], page 12, or VME64x[2], page 58, a warning is issued.
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 7 The Simulator
sued M
The Simulator can be used where the Vanguard Hardware is not available. It allows most of the fea-
tures in BusView to be used without having a connection to the Vanguard Hardware.

• Starting the Simulator
• Using the Analyzer with the Simulator
• Using the Statistics Functions with the Simulator
• Using the Protocol Checker with the Simulator
• Using the Exerciser with the Simulator

Note – All features are available in Simulator mode regardless of which options have been 
purchased.
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7.1 Starting the Simulator

BusView connects to the Simulator in the same way it connects to the Vanguard hardware. The 
Simulator is presented as an available device in the Device Information dialog box.

Step-by-step Instructions to start the Simulator

These steps assume that you have already installed BusView onto your PC.

1. Start BusView by double-clicking on the BusView icon on your desktop.
2. BusView will begin by performing a scan to find available connections.
3. Select the Simulator by clicking on the check box and click OK.
4. The next dialog box will ask which mode you wish to run the Simulator, PCI, PCI-X or VME. 

Choose one by clicking on it’s radio button and then click OK.

BusView is now connected to the Simulator.

Note – To switch between modes it is necessary disconnect from the Simulator, and re-connect in 
the required mode.
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7.2 Using the Analyzer with the Simulator

The Simulator makes use of several pre-saved Trace Files. These are used to simulate Sampling of 
the bus and the acquisition of Trace/Trigger Control data.

It is important to realize that the trace shown after the Analyzer has triggered in Simulator mode, 
bears no relation to the Event Patterns defined in the Analyzer Setup Window. However, there are 
some conditions used to determine which trace file is displayed.

There are three trace files for each of the Sampling Modes:

• PCI/PCIX Clock Mode (Multiplexed)
• PCI/PCIX Standard Mode (Demultiplexed)
• PCI/PCIX Transfer Mode (Demultiplexed)
• VME State Mode
• VME Timing Mode

Each of the three trace files have a different Trigger Position, 0%, 50% and 100%. When the 
Analyzer is run, the trace file chosen for display is determined as that which is closest to the chosen 
trigger position defined in the Analyzer Setup Options. To summarize:

For PCI and PCIX:

A total of eighteen trace files exist for PCI simulation, nine each for PCI and PCI-X bus modes.

For VME:

A total of six trace files exist for VME simulation, three each for State and Timing sampling modes.

Standard Mode

PCI or PCI-X

Clock Mode Transfer ModeSampling Mode

Bus Mode

Trigger Position 0% 50% 100% 0% 50% 100% 0% 50% 100%

Trace FilesTrace Files Trace Files

Sampling Mode

Trigger
Position

Timing Mode

VME

State Mode

Bus Mode

Trace Files

0% 50% 100%

Trace Files

0% 50% 100%
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7.3 Using the Statistics Functions with the Simulator

There are pre-recorded statistics files which are used by the Simulator to display the play back of 
statistics charts.

The Simulator selects the pre-recorded statistics file depending on which bus mode (PCI, PCI-X or 
VME) and Sampling Modes has been chosen from the Statistics Setup Window

The Statistics Charts displayed after the Statistics Function has been run bears no correlation to the 
settings implemented in the Statistics Setup Window.

Standard Mode

PCI or PCI-X

Clock Mode Transfer ModeSampling Mode

Bus Mode

Statistics Files
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7.4 Using the Protocol Checker with the Simulator

The Simulator will generate random errors when the Protocol Checker is run. The error will be 
displayed on the Protocol Checker window according to the setting chosen in the Protocol Checker 
Options dialog.
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7.5 Using the Exerciser with the Simulator

The Simulator reacts depending on the type of Exerciser command

Master Commands issued will result in OK status being returned. No real bus traffic is generated.

Local Commands operate on allocated PC memory and operate normally.

Script Commands operate normally and it is possible to build and execute scripts using the 
Simulator. This is useful for debugging scripts offline.
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 8 Exerciser
sued M
The Exerciser is used to generate cycles with known characteristics on the VME bus.

• Introduction
• Operation
• Executing Commands
• Configuration Scan
• Using Scripts
• Exerciser Script Commands

Use of the Exerciser requires the “VG-E” license to have been 
purchased. See “Ordering Information” on page 241.
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8.1 Introduction

The main features of the Exerciser

• Provides D32, D16, D8 and UAT under A32, A24 and A16 addressing modes plus D64 BLT and 
D32BLT under A64, A32 and A24 addressing modes.

• As a VME master in DMA mode, the Exerciser provides A64, A32, broadcast A32 and 
broadcast A64 2eSST transaction.

• Provides real VME cycles with nominal bus timing.
• Can be used in conjunction with the Vanguard Analyzer, Protocol Checker and Statistics.
• A script engine is included.
• Can emulate any VME board and has 8 MByte slave memory available for use.
• DMA transfers can be set up with the Exerciser acting as a “slave” or a “master”.
• Can generate any VME interrupts.

The Exerciser is useful for:

• Assist in the debugging of boards by sending signals to a board under inspection, and monitor 
it’s behavior.

• Inspect and patch data in memory without interfering with the operation of other masters on the 
bus.

• Testing behavior during violations.

FIGURE  8-1 
Exerciser 
Block Diagram

 

Command Memory. This area contains the list of commands that will be executed onto the VME 
bus.

Command Executer. Controls the VME Core. It reads commands from the Command Memory 
and sends status reports back to BusView.

VME Core. These are the FPGA images used to act as a VME Exerciser.

RAM. This memory area is for use in DMA transfers and in mapping target memory. 

VME
Core RAM

Command Memory

VANGUARD
Exerciser

Command
Executers

Command

VME Bus
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8.2 Operation

Start the Exerciser by right-clicking on the Exerciser folder in the Workspace Window and clicking 
on New. Click on Open if you wish to retrieve a previous Exerciser session.

Exerciser Window

The Exerciser Window provides a command line interface to issue commands, and an area where 
the results of issued commands are displayed.

FIGURE  8-2 
Exerciser 
Window
175Issued May 4, 2004 Vanguard User Guide



Exerciser VMETRO
The Exerciser toolbar and menu 

As an alternative to executing Exerciser commands from the Command 
Line, the Exerciser Menu and toolbar can be used to define and execute 
commands

Activate. Enables the Exerciser

 Master. Opens the Exerciser Master Commands dialog.

 Command Executer. Opens the Command Executer dialog.

 Target. Opens the Exerciser (Slave) dialog.

 Local. Opens the Exerciser Local Commands dialog.

 Interrupts. Opens the Interrupt dialog.

 Configuration Scan. Executes the Scan command.
Scan can also be executed from the command line by typing “scan”.

Refresh Exerciser Status. Get an updated Exerciser Status.

DMA Abort. Abort any DMA operation currently in progress.

Script. Use the Exerciser Scripting features. See “Using Scripts” on page 212.

Help

The Exerciser provides several ways of getting help.

• When typing a command in the command line, the text color will change. When the text is red, 
this means that the command does not yet have all necessary parameters to be executed.

• Context sensitive help. Type a command in the Exerciser window, and press Ctrl-F1 keys. The 
on-line help opens at the page describing the command.

• Type "h" or "?" followed by a command, and a list of arguments appears in the Exerciser 
window.

Use the on-line help manual available by pressing the help button at the tool bar.
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Exerciser Options

Right-click on the Exerciser Window and click Options to open the Exerciser Options Window.

Performance Options

FIGURE  8-3 
Exerciser 
Performance 
Options

 

• Bus Level -Bus Level to use for the commands 0 - 3
• BBSY* Release - BBSY* Release type. Available options are:

• ROR -Release On Request.
• RWD - Release When Done.
• ROC - Release On Clear.
• RNE - Release NEver.

• 2eSST Speed - Options are:
• VERYSLOW - SST160,  effective rate 146MBytes/s.
• SLOW - SST267,  effective rate 171MBytes/s.
• MEDIUM - SST267,  effective rate 205MBytes/s.
• FAST - SST267,  effective rate 256MBytes/s (default).
• ULTRAFAST - SST320+, effective rate 341MBytes/s.

• Fairness Timer - Options are:
• Inifinite - Vanguard does not assert a VME request if another request is already 

pending on the same level.
• 20 us - Assert request after 20 micro seconds or when released by other devices.
• None - Vanguard asserts the request immediately.
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These options can also be set via the command line prompt with the opt command:
opt <enable>[bus_level] [BBSY_release] [2eSST_speed] [fairness_timer]

System Controller

• Arbitration - Select the type of VME bus arbitration. Round Robin, or Priority.
• Timout - Timeout for data transfers on the VME bus in micro seconds.

These options can also be set via the command line prompt with the optx command:
optx <enable>[arbitration_type] [timeout] 

Argument Description Default

Required Optional Type

enable BOOL 1= Enable Exerciser, 0= Disable Exerciser 0

bus_level number Bus Level to use for the commands 0 - 3 3

BBSY_release text BBSY* release type
ROR = Release On Request.
RWD = Release When Done.
ROC = Release On Clear.
RNE = Release NEver.

ROR

2eSST_speed text VERYSLOW = SST160,  effective rate 146MBytes/s.
SLOW = SST267,  effective rate 171MBytes/s.
MEDIUM = SST267,  effective rate 205MBytes/s.
FAST = SST267,  effective rate 256MBytes/s (default).
ULTRAFAST = SST320+, effective rate 341MBytes/s.

FAST

fairness_timer number 0= None
1= 20us
2= Infinite

0

Argument Description Default

Required Optional Type

enable BOOL 1= set parameters
0= reset to default

0

arbitration_type text rr= Round Robin
p = Priority

timeout number Data to bus error timout in microseconds
0 (default) - 255us. Zero means timer is inactive (no timeout)
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FIGURE  8-4 
Exerciser User 
Input Options

User Input

Require user input on test and compare - 

• If this is enabled and a Test command is running; if an error occurs then testing 
will stop and wait until Next is pressed before continuing. 

• If disabled and a Test command is running; if an error occurs then testing will 
continue. Errors are displayed in the Output Log.

FIGURE  8-5 
Exerciser 
Output Settings 
Options

Output Settings

• Number of lines in output to view - states the maximum number of lines to be viewed in 
the Output Log. When the maximum is reached, the oldest line is removed when a new 
line is created.

• Log exerciser output to the following file: - Selecting this will allow you to specify a file 
in which all Exerciser output will be saved.
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8.3 Executing Commands

Executing Single commands

There are 2 ways of executing commands on the Exerciser:

• By typing commands at the command line prompt in the Exerciser Window.
• By using the dialog boxes available from the Script, Master, Target, Interrupt, Local, and the 

Options menus.

Some of the commands have several arguments. Arguments can be required or optional:

• <argument> = required.
• [<argument>] = optional.

When using the command line interface, all required arguments have to be specified. When using 
dialog boxes, the arguments have default values.

Executing Multiple Commands

Command Executer

The Command Executer is used to issue a list of Cycle Sequences. The Fields available in 
this dialog will alter depending on the AM/XAM code used.When executed, the whole list is 
transferred to the Vanguard, where it is run in hardware - as fast as possible. 

Scripts

Scripts can be made to allow lists of commands to be executed without user intervention. 
Scripts are text files which can be edited in any text editor and simulate commands typed in 
by the keyboard. each command is executed before the next one is read. See “Using Scripts” 
on page 212.
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213

213

214

214

214

214

215

215

215

215
8.4 Summary of Commands

 

Master Commands Local Commands Miscellaneous Commands Script Commands

Modify 184 Local Display 201 Refresh 207 Start Recording

Write 185 Local Modify 202 Target 208 Stop Recording

Fill 186 Local Fill 203 Interrupt 209 Load Script

DMA 188 Local Copy 204 Interrupt Acknowledge 210 Run Script

Test 191 Local Load 205 Exerciser Options 177 Wait

Compare 193 Local Save 206 Help 176 Pause

Cycle Sequence 195 Loop

Exercise 197 End

Load Memory 199 Show

Save Memory 200 Comment
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Where AM/XAM codes are used, the following table is valid:

* Not available in Modify
** Only used in commands that perform a Write operation.

TABLE 8-1. Mnemonics for AM/XAM hex codes

Mnemonic  Value(hex)     Mnemonic  Value(hex)

A32LCK  05     CRCSR  2F

A32nMBLT*  08    --------------- ----

A32nD  09 A24LCK 32

A32nP  0A A24nMBLT* 38

A32nBLT*  0B A24nD 39

A32sMBLT*  0C A24nP 3A

A32sD  0D A24nBLT* 3B

A32sP  0E A24sMBLT* 3C

A32sBLT*  0F A24sD 3D

--------------- ------ A24sP 3E

A64MBLT* 00 A24sBLT* 3F

A64D 01  ------------- ------

A64BLT* 03 A16nD 29

A64LCK 04 A16LCK 2C

----------------- ---- A16sD 2D

A32D64_2eSST 2011

A64D64_2eSST 2012

A32D64_2eSSTBC ** 2021

A64D64_2eSSTBC ** 2022
182 Vanguard User Guide Issued May 4, 2004



Summary of CommandsVMETRO
Display

Displays Memory space in 256 Byte blocks.

Command Line format:

d <start_addr>[am/xam][<data_size>][<block_len>] [<end_addr>]

 

Example: d 80001000 A32sD 4 0

d = Display command
1000 = start address
A32sD = am code
4 = 4 byte accesses (DWORD)
0 = number of bytes

Argument Description Default

Required Optional Type

start_addr Hex number Start address of area to display.

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the 
value should be a 4 digit hexadecimal 
number where the 1. byte is 20 and the 2. 
byte is the xam code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as 
mnemonic instead of hex, see Table 8-1 on 
page 182

0D or 
A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

end_addr hex number End address of the area to display. 
Maximum is start_addr + FFFF

FF

Note – The end_addr argument is used to set the block size of the Display command, i.e. if the 
end_addr is set to start_addr+0x7f, only 0x80 bytes of data are displayed in each block.
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Modify

Read and Modify data in memory space.

Command Line format:

m <start_addr>[<am>] [<data_size>]]

 

Example: m 1000 A32sD 4 r w

m = Modify command
1000 = start address
A32sD = am code
4 = 4 byte accesses

Argument Description Default

Required Optional Type

start_addr Hex number Start address of area to display.

am char Address modifier 
hex value in range 00-3F 
The modifier can also be given as 
mnemonic instead of hex, see Table 8-1 
on page 182

0D or 
A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4
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Write

Used to write data into Memory space.

Command Line format:

w <start_addr>[<am/xam>][<data_size>] [<block_len>] [<slave_select>]

 

Example: w 1000

w = Write command
1000 = start address.

When the block option is used, the data is entered at the desired address in the same way as for 
single cycle. However, the data is not written until the command is executed, or until the number of 
bytes entered is equal to the block length.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of area to display.

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the 
value should be a 4 digit hexadecimal 
number where the 1. byte is 20 and the 2. 
byte is the xam code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as 
mnemonic instead of hex, see Table 8-1 
on page 182

0D or A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

slave_select Hex number The slave select address for 2eSST 
broadcast.
Third address phase as 32 bits value 
where A[21:1] is used.

0x3FFFFE
(all selected)
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Fill

Fills Memory space with a given pattern or value.

Command Line format:

f <start_addr><end_addr><value>
[<am/xam>][<data_size>][<block_len>][<local_addr>][<slave_select>]]

  

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

value Hex number
or char

The value to fill into the area
char values:
o = Walking one pattern 
z = Walking zero pattern
s = address as data 
r = random data 
l = use data in “local addr”

o

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam 
code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

local_addr hex number Local memory address of data pattern

slave_select Hex number The slave select address for 2eSST broadcast.
Third address phase as 32 bits value where 
A[21:1] is used.

0x3FFFFE
(all selected)
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Example: f 1000 10ff o m 4 8

f = Fill command
1000 = start address
10ff = end address
o = Walking One fill pattern
A32sD = am code
4 = 4 bytes data size and 8 = block length in bytes

Fill a user-defined pattern:

The value argument specifies which kind of fill pattern to be used. Using value=l in conjunction 
with the local_addr argument, causes the pattern at local_addr to be used as fill pattern.

A user-defined pattern can be filled into the local user memory area starting with local_addr, before 
the Fill command is started. This can be done using the Local Fill and the Local Modify commands.

See also the Save and Load commands for saving patterns to disk.
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DMA

The DMA (Direct Memory Access) command initiates a DMA transfer between a target and the 
Exerciser Local User Memory. The DMA command may take an argument specifying that the 
DMA transfer should loop forever, transferring the same block in an endless loop. This option is 
effective for creating heavy traffic on the bus.

The Vanguard has 1 DMA channel available.

DMA Transfers can be made in three different ways:

• Local to VME - Transfers data from Local (Target) memory to a VME location. i.e from 
Exerciser to Device #1 in the diagram shown.

• VME to Local - Transfers data from a VME location to local memory. i.e. from Device #1 to the 
Exerciser in the diagram shown.

• VME to VME - Transfers data from a VMElocation to local memory, and then from local 
memory to another VMElocation. i.e. from Device #1 to Device #2 via the Exerciser in the 
diagram shown.

 

Note – The DMA command runs in the background and the command prompt will return after 
starting the DMA transfer. This means that other commands can be entered without having to 
wait for the DMA transfer to finish.

Note – A DMA transfer can be aborted by running the DMA abort command.

Exerciser

Device
#1

Device
#2

VME Bus
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Command Line format:

dma <src_addr> <dst_addr> <transfer_size> [<data_size>] [<dir>] [<repeat>] [<am/xam>] 
[<block_len>] [start_on_trg] [<slave_select>]]

 

Argument Description Default

Required Optional Type

src_addr Hex number Source start address

dst_addr Hex number Destination start address

transfer_size Hex number Number of bytes to transfer

data_size unsigned int Size of each data object  4 or 8 bytes 4

dir char[2] vv = VME to VME memory
vl = VME to local memory
lv = local to VME memory

vv

repeat unsigned_int Number of times to repeat the DMA transfer
0 = forever

1

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or A32sP

block_len unsigned int block length in cycles 1-256 1

start_on_trg BOOL Start DMA transfer on trigger from the Analyzer
1= Enable
0= Disabled

slave_select Hex number The slave select address for 2eSST broadcast.
Third address phase as 32 bits value where 
A[21:1] is used.

0x3FFFFE
(all selected)
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Example: dma 10000 20000 1000 4 vv 4

dma = DMA command
10000 = source start address
20000 = destination start address
1000 = bytes to transfer
4= 4 bytes data size
vv = VME to VME transfer
4 = repeat 4 times.

A DMA transfer of 0x1000 bytes from address 0x10000 to address 0x20000 is executed 4 times.

A user-defined pattern can be filled into the local user memory area starting with local_addr, 
before the DMA transfer is started. This can be done using the Local Fill and the Local Modify 
commands.

See also the Save and Load commands for saving patterns to disk.

Status Line Information

The status line at the bottom of the BusView window shows a green indicator in the DMA fields if 
a DMA (started with the DMA command) is active.

If no DMA is active, and the DMA status line field is grayed, a double mouse click on the DMA 
field, will open the DMA dialog box.

If a DMA is active, and the green indicator is on, a double mouse click on the field will terminate 
the DMA. The indicator will then change color to dark green.

Arbitration: The arbitration is set in the .
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Test

Repeatedly fills Memory space with a given pattern, reads it back, and checks for errors.

Command Line format:

t <start_addr> <end_addr> [<value>] [<repeat>] [<am/xam>][<data_size>] [<block_len>] 
[<local_addr>]]

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

value Hex number
or char

The value to fill into the area
char values:
o = Walking one pattern 
z = Walking zero pattern
s = address as data 
r = random data 
l = use data in “local addr”

o

repeat unsigned_int Number of times to repeat the DMA transfer
0 = forever

1

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam 
code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or 
A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

local_addr hex number Local memory address of data pattern
191Issued May 4, 2004 Vanguard User Guide



Exerciser VMETRO
Example: t 10000 1ffff o 32 A32sD 4 256

t = Test command
10000 = start address
1ffff = end address
o = Walking One pattern
32 = repeat 32 times
A32sD = am code
4 = 4 byte accesses
256 = block length.

The result is a test that writes 0xffff bytes of walking a one pattern to VME address 0x10000, 
reads them back, and checks whether any errors have occurred in the operation. This procedure is 
performed 32 times, or until the user terminates the test by pressing the Quit button, or one of the 
keyboard keys ‘q’, ‘Q’, ‘Esc’, or ‘.’.

Test with a user-defined pattern:

The value argument specifies which kind of test pattern to be used. Using value=l in conjunction 
with the local_addr argument, causes the pattern at local_addr to be used as test pattern.

A user-defined pattern can be filled into the local user memory area starting with local_addr, 
before the test is started. This can be done using the Local Fill and the Local Modify commands.
See also the Save and Load commands for saving patterns to disk.

EXERtrg# on verify error:

The Test command asserts a trigger signal (EXERtrg#) to the VME Bus Analyzer when a verify 
error occurs. For each verify error, the test stops and waits for user input, either to terminate the test, 
or to continue. Use the buttons at the bottom of the Exerciser window. Keyboard keys are ‘q’, ‘Q’, 
‘Esc’, or ‘.’ to quit, or any other key to continue.

It is required to run the test with single cycles when the EXERtrg# trigger signal is taken into use in 
the analyzer, because the trigger signal is asserted during the verify process. When block cycles are 
used, an error can occur in the first transfer of the block, but the trigger signal will not be asserted 
until the block is finished and the verify process has started.
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Compare

Repeatedly reads Memory space, and compares the data with a given pattern.

Command Line format:

c <start_addr> <end_addr> [<value>] [<repeat>] [<am/xam>][<data_size>] 
[<block_len>][<local_addr>]]

 

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

value Hex number
or char

The value to fill into the area
char values:
o = Walking one pattern 
z = Walking zero pattern
s = address as data 
r = random data 
l = use data in “local addr”

o

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam 
code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or 
A32sP

repeat unsigned_int Number of times to repeat the DMA transfer
0 = forever

1

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

local_addr hex number Local memory address of data pattern 0
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Example: c 10000 1ffff o 1 A32sD 4 4 rm

c = Compare command
10000 = start address
1ffff = end address
o = Walking one
1 = do not repeat
A32sD = am code
4 = 4 bytes accesses
4 = 4 bytes block length

The result is a test that reads 0xffff bytes from address 0x10000 with four bytes accesses, and 
compares the data with a walking one pattern.

This procedure is performed once, or until the user terminates the test by pressing the Quit button at 
the bottom of the Exerciser window, or one of the keyboard keys ‘q’, ‘Q’, ‘Esc’, or ‘.’.

Test with a user-defined pattern:

The value argument specifies which kind of test pattern to be used. Using value=l in conjunction 
with the local_addr argument, causes the pattern at local_addr to be used as test pattern.

A user-defined pattern must be filled into the local user memory area starting with local_addr, 
before the test is started. This can be done using the Local Fill and the Local Modify commands.

See also the Save and Load commands for saving patterns to disk.

EXERtrg# on verify error:

The Compare command asserts a trigger signal (EXERtrg#) to the VME Bus Analyzer when a 
verify error occurs. For each verify error, the test stops and waits for user input, either to terminate 
the test, or to continue. Use the buttons at the bottom of the Exerciser window. Keyboard keys are 
‘q’, ‘Q’, ‘Esc’, or ‘.’ to quit, or any other key to continue.

It is required to run the test with single cycles when the EXERtrg# trigger signal is taken into use in 
the analyzer, because the trigger signal is asserted during the verify process. When block cycles are 
used, an error can occur in the first transfer of the block, but the trigger signal will not be asserted 
until the block is finished and the verify process has started.
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Cycle Sequence

Generates a sequence of VME cycles. Only error messages are output. This command is useful to 
put traffic on the bus.

Command Line format:

q <start_addr> <end_addr> [<dir>][<repeat>]  [<am/xam>] [<data_size>] [<block_len>] [<value>] 
[<local_addr>][<slave_select>]

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

repeat unsigned_int Number of times to repeat the DMA transfer
0 = forever

1

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam 
code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or A32sP

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4

block_len unsigned int block length in cycles 1-256 1

value Hex number
or char

The value to fill into the area
char values:
o = Walking one pattern 
z = Walking zero pattern
s = address as data 
r = random data 
l = use data in “local addr”

o

local_addr hex number Local memory address of data pattern 0

dir char Transfer direction:
r = read
w = write

r

slave_select Hex number The slave select address for 2eSST broadcast.
Third address phase as 32 bits value where 
A[21:1] is used.

0x3FFFFE
(all selected)
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Example: q 20000 200ff 1 c

q = Cycle Sequence command
20000 = VME start address
200ff = VME end address
1 = never repeat (repeat count 1)

Place a user-defined pattern on the bus:

The value argument specifies which kind of pattern to be used. Using value=l in conjunction with 
the local_addr argument, causes the pattern at local_addr to be used.

A user-defined pattern can be filled into the local user memory area starting with local_addr, 
before the Cycle Sequence command is started. This can be done using the Local Fill and the Local 
Modify commands.

See also the Save and Load commands for saving patterns to disk.
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Exercise

Reads and writes cycles with varying data sizes.

For example: if a memory area, a pattern, and a Write command is selected, then the pattern is 
applied to the bus four times (presuming repeat count is 1). First with a data size of 1 byte, second 
with a data size of 2 bytes, third with a data size of 4 bytes, and fourth with a data size of 8 bytes.

Command Line format:

x <start_addr> <end_addr> [<value>] [<repeat>] [<block_len>][<am/xam>] [<local_addr>]

 

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

value Hex number
or char

The value to fill into the area
char values:
z= Walking zero pattern is filled into the area
o = Walking one pattern is filled into the area
s = address as data is filled into the area
r = random data is filled into the area
l = use data in “local addr”

o

repeat unsigned int Number of times to repeat the DMA transfer
0 = forever

1

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value 
should be a 4 digit hexadecimal number where 
the 1. byte is 20 and the 2. byte is the xam 
code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic 
instead of hex, see Table 8-1 on page 182

0D or 
A32sP

block_len unsigned int block length in cycles 1-256 1

local_addr hex number Local memory address of data pattern 0
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Example: x 0 8000000 ABBACAFE 0

x = Exercise command
0 = VME start address
8000000 = VME end address
ABBACAFE = data fill pattern
0 = infinite repeat.

Place a user-defined pattern on the bus:

The value argument specifies which kind of pattern to be used. Using value=l in conjunction with 
the local_addr argument, causes the pattern at local_addr to be used.

A user-defined pattern can be filled into the local user memory area starting with local_addr, 
before the Exercise command is started. This can be done using the Local Fill and the Local Modify 
commands.

See also the Save and Load commands for saving patterns to disk.
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Load Memory

Data files previously generated with the Save or Local Save commands, can be loaded into VME 
memory using the Load command.

Command Line format:

l <start_addr><end_addr> [<am/xam>][<slave_select>][file_name]

 

Example: l 0 fff

0x1000 bytes of data will be loaded from the file to VME memory, starting from VME address 
0x0.

If no filename is entered, a dialog box will open, asking for the location and name of the file to load.

Abort operation

Press the Quit button at the bottom of the VME Exerciser window, or any of the ‘Q’, ‘q’, ‘Esc’, or 
‘.’ keys, to abort the Load command.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value should be a 4 
digit hexadecimal number where the 1. byte is 20 and the 2. 
byte is the xam code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic instead of 
hex, see Table 8-1 on page 182

0D or A32sP

slave_select Hex number The slave select address for 2eSST broadcast.
Third address phase as 32 bits value where A[21:1] is used.

0x3FFFFE
(all selected)

[<filename>] string Name of the file to load.
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Save Memory

Save VME memory to file.

Command Line format:

s<start_addr><end_addr> [<am/xam>][file_name]

 

Example: s 0 fff

The VME Exerciser will perform Memory Read cycles on the VME bus, from start address 0x0 to 
end address 0xFFF (inclusive), and save the data to a file.If no filename is entered, a dialog box will 
open, asking for the location and name of the file to save.

The file is in standard ASCII format, and can be read in any text editor. It is also possible to edit the 
file manually, but be careful not to change the length or format of the file, as this may cause unusual 
behavior when trying to load it at a later time.

Abort operation

Press the Quit button at the bottom of the VME Exerciser window, or any of the ‘Q’, ‘q’, ‘Esc’, or 
‘.’ keys, to abort the Save command.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

am/xam char Address modifier 
hex value in range 00-3F if am = 20 the value should be a 4 
digit hexadecimal number where the 1. byte is 20 and the 2. 
byte is the xam code.
Valid xam codes are 11, 12, 21 or 22.
The modifier can also be given as mnemonic instead of 
hex, see Table 8-1 on page 182

0D or A32sP

[<filename>] string Name of the file to save the data in.
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Local Display

The Vanguard Exerciser has 8MB of Local User Memory. The Local Display command allows the 
user to dump Local User Memory in 256Byte blocks for display. The Local User memory ranges 
from address 0x0 to 0x7FFFFF and can be mapped as target memory using the Target command.

Command Line format:

ld <addr>[<data_size>] [file_name]

Example: ld 200000 2

ld = Local Display command
200000 = Local User Memory start address
2 = 2 bytes display format.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the area

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4
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Local Modify

Displays data with data size 1, 2, 4, or 8 bytes, at a given local user address, and optionally allows 
Local User Memory modification. 

The local memory addresses range from 0x0 to 0x7FFFFF. 
Use hexadecimal values to modify the local memory.

Command Line format:

lm <start_addr> [<data_size>]]

Example: lm a000 1

lm = Local Modify command
a000 = Local User Memory start address
1 = 1 byte display format.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the area

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4
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Local Fill

Fills local user memory on the Exerciser, with a given data pattern or value

Command Line format:

lf <start_addr> <end_addr> <value> [<data_size>]

Example: lf 100000 1fffff 1234 2

lf = Local Fill command
1000 = Local User Memory start address
1fff = Local User Memory end address
1234 = data to fill into area
2 = data size.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

value Hex number
or char

The value to fill into the area
char values:
z = Walking zero pattern is filled into the area
o = Walking one pattern is filled into the area
s = address as data is filled into the area
r = random data is filled into the area

o

data_size unsigned int Size of each data object 1, 2, 4 or 8 bytes 4
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Local Copy

Copies local user Exerciser memory from one location to another.

Command Line format:

lc <start_addr> <end_addr> <dst_addr>]

Example: lc 100000 10ffff 400000

lc = Local Copy command
1000 = Local User Memory start address
10ff = Local User Memory end address
4000 = Local User Memory destination address.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

dst_addr Hex number Start address of destination area
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Local Load

Data files previously generated with the Save or Local Save commands, can be loaded into Local 
User Memory using the Local Load command.

Command Line format:

ll <start_addr> <end_addr> [<filename>]

Example: ll 0 fff

In the above example, 0x1000 bytes of data will be loaded from a file to Local User Memory, 
starting from local address 0x0.

If no filename is entered, a dialog box will open, asking for the location and name of the file to load.

Abort operation

Press the Quit button at the bottom of the VME Exerciser window, or any of the ‘Q’, ‘q’, ‘Esc’, or 
‘.’ keys, to abort the Local Load command.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

[<filename>] string Name of the file to load.
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Local Save

Saves Local User Memory to file.

Command Line format:

ls <start_addr> <end_addr>]

Example: ls 0 fff

The PCI/PCI-X Exerciser will read the Local User Memory from start address 0x0 to end address 
0xFFF (inclusive), and save the data to a file.

If no filename is entered, a dialog box will open, asking for the location and name of the file to 
save.

The file is in standard ASCII format, and can be read in any text editor. It is also possible to edit the 
file manually, but be careful not to change the length or the format of the file, as this may cause 
unusual behavior when trying to load it at a later time.

Abort operation

Press the Quit button at the bottom of the VME Exerciser window, or any of the ‘Q’, ‘q’, ‘Esc’, or 
‘.’ keys, to abort the Local Save command.

Argument Description Default

Required Optional Type

start_addr Hex number Start address of the fill area

end_addr Hex number End address of the fill area

[<filename>] string Name of the file to save the data in.
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Refresh

Refresh the Exerciser DMA, interrupt and target status.
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Target

Maps VME target window into Local User Memory. When activated, parts of the Local User 
Memory can be accessed by other VME bus masters. This is how the Exerciser can emulate a VME 
slave memory device.

Command Line format:

target <enable>[<vme_base>][size]

 

Example 1: target 1 80000000 

target = Target command
1 = enable a target window
80000000 = VME start address of window

Example 2: target 0 

target = Target command
0 = disable the target window

Status Line Information

The status line at the bottom of the BusView window displays the current target window status.

Argument Description Default

Required Optional Type

enable BOOL Enable/Disable:
1 = Enable
0 = Disable

0

vme_base hex number VME start address of the window
Value must be specified if enabled.

size hex number Size in hex bytes 100000 - 800000 800000
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Interrupt

The Interrupt command generates VME interrupts.

Command Line format:

int <enable> <irq_line> [vector]

 This command can also be executed by pressing the 

Interrupt button  on the toolbar, or clicking 
Interrupt(s) from the Exerciser menu, and then 
choosing an interrupt from the dialog box that 
appears:

Example 1: int 1 2

int = int command
1 = enable interrupt
2 = interrupt line.

Example 2: int 0 2

int = int command
0 = disable interrupt
2 = interrupt line.

Status Line Information

The status line at the bottom of the BusView window identifies the active interrupt line. LEDs 
marked 1-7are active if the corresponding interrupt line is enabled.

The same information can be found by simply typing “int” at the VME Exerciser prompt.

Argument Description Default

Required Optional Type

enable BOOL 1 = Enable Interrupt
0 = Disable Interrupt

irq_line char VME interrupt request line. Valid values are 1 
to 7.

vector int The interrupt vectors (0x00-0xFF). Vector to 
be returned on interrupt acknowledge is bit 7:3 
from this vector and the irq level encoded as 
bit 2:0
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Interrupt Acknowledge

The Interrupt Acknowledge command generates interrupt acknowledge cycles on the VME bus.

Command Line format:

intack <irq_lines>

where:

irq_lines - Interrupt line to generate (up to 7 digits each different and in range 1-7).
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8.5 Configuration Scan

The Exerciser can perform a complete scan of VME configuration space. It systematically probes 
for all possible devices on the bus that the Vanguard is located on.Performing a Configuration Scan

The Configuration Scan can be started using one of the following methods:

• Click the Config Scan button  on the toolbar.
• Click Configuration Scan on the Exerciser Menu.
• Type scan into the Exerciser Command Prompt.

When the scan is complete, the Bus Devices window will open, listing the results of the scan.

Bus Devices

The results of a Configuration Scan are displayed in the Bus Devices window.

FIGURE  8-6 
Configuration 
Scan Results

 

Figure 8-6 shows an example results of a Config Scan command. The tabs Header Layout, 
Information and Register display the same information, but in different ways.

• Header Layout - Information is formatted the same as that issued in the VME specification.
• Information - Relevant information is organised together. for example, IDs are shown together.
• Registers - Information is organised by address.

It is also possible to perform a scan from the Host PC. See “Host PC” on page 42 for details.
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8.6 Using Scripts

An Exerciser script is a list of commands that can be executed without user intervention. These 
commands are listed in a text file which can be edited in any text editor.

In addition to the usual Exerciser commands, there are also Script Commands for use in scripts. 
These commands allow scripts to incorporate loops and delays.

Record a Script
1. Click Start Recording from the Exerciser, Script menu or type rec_start in the command line.
2. Type a filename for the script file and choose a location to store it.
3. Every Exerciser command executed now will be recorded into this script file. The Script 

Commands are also now available.
4. Click Stop Recording from the Exerciser, Script menu or type rec_stop in the command line 

to finish.

Execute a Script
1. Click Load Script from the Exerciser, Script menu or type dls in the command line.
2. The script is now loaded into memory and awaiting execution.

To run the script once; click Run from the Exerciser, Script menu, type run in the command 
line, or press F10.
To run the script a number of times; click Run Loop from the Exerciser, Script menu, type run 
[number_of_times] in the command line, or press Ctrl + F10.

3. The script will now run and any results displayed in the Output Area.
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8.7 Exerciser Script Commands

Script commands can be entered via the command line found in the Exerciser window, or by using 

the menus “Exerciser, Script” or by right-clicking the mouse in the Exerciser Window. It is also 
possible to custimize the BusView toolbar to include Script Commands. This is done by right-
clicking on the busview toolbar and selecting “Scripts”

 A Script toolbar can be added to BusView by right clicking on the 
toolbar and selecting “Scrip”.

Start Recording

The Start Recording command starts recording of an Exerciser script. It does this by recording all 
executed commands to a file.

Command Line format:
rec_start [file_name]

Optional Command argument:
[file_name] - used to specify the path and filename of the script file to be recorded. If this 
parameter is not used, a dialog will prompt for the path and filename details.

The header of the Exerciser window displays the name of the script file being recorded.

The script file is in standard ASCII format and can be edited manually with any text editor. Any 
errors in the file will simply make the Exerciser display a help text when the script is run, in the 
same way as when an erroneous command is typed at the Exerciser prompt.

To enter a comment into the script file, the line has to start with a “#” character.

Blank lines are interpreted as CRs.

Stop Recording

The Stop Recording command displays a dialog box to confirm that you wish to stop recording. If 
the OK button is pressed recording is stopped.

Command Line format:
rec_stop
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Load Script

The Load command opens a previously recorded script file.

Command Line format:

dls [file_name]

Optional Command argument:
[file_name] - used to specify the path and filename of the script file to be loaded. If this 
parameter is not used, a dialog will prompt for the path and filename details.

Run Script

Runs the script previously loaded with the Load command. The name of the script file appears in 
the header of the PCI Exerciser window.

Run Loop can be selected from the Script Menu.

Command Line format:
run [number_of_times]

Optional Command argument:
[number_of_times[ - Number of times to run the script. 1 is default, 0 is run forever

Wait

Enter a number of milliseconds to wait.

Command Line format:
wait <number_of_ms>

Command argument:
number_of_ms - Number of milliseconds to wait.

Pause

Inserts a pause statement in the script file. When a pause is present, press a key to continue.

Command Line format:
pause
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Loop

Inserts a loop into the script.

Command Line format:
loop <number_of_loops>

Command argument:
number_of_loops - Number of times to iterate the loop segement.

End

Inserts an "end" statement into the script file which marks where the end of the loop is.

Command Line format:
end

Show

Shows the contents of the script currently held in memory.

Command Line format:
show

Comment

Inserts a comment to the script file indicated with a "#" at the beginning of the line.

Note – A loop segment must consist of: a “loop n” command, and an “end” command to indicate 
the end of the looped segment.
loop n
..
 "loop segment"
..
end
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A-1 Vanguard Specifications

Power Consumption

General

TABLE A-1. Vanguard VME 5.0V

Min(Idle) Max
Sampling Clock 
frequency

1.52A Without Exerciser 1.68A State mode without Exerciser  -

1.52A Without Exerciser 2.78A Timing Mode without Exerciser  133 MHz

2.12A With Exerciser 4.0A Timing Mode with Exerciser 133 MHz

VME bus: Up to 320 MB/s (2eSST320)

Interfaces: USB port, 12 Mb/s.
Ethernet port 10/100 Mb/s

Power supply 
requirements:

+5VDC +/-5% from VME connector or from ext. power supply via front panel 
inlet.

Dimensions: 160 x 233.4 mm (6U)

Compliant to: ANSI/VITA 1-1994 VME64 Standard
ANSI/VITA 1.1-1997 VME64 Extensions
ANSI/VITA 1.5-2003 2eSST

Operating Temperature:  0-50 ºC / 32-248 ºF

Measurements: Temperature: 0-120 °C/ 32-248°F
Voltage: 3.3V, 5V, 12V
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Analyzer

Exerciser (Optional Module)

Protocol Checker

Statistics

Trace Memory: 2M x 256 bits (64 MBytes total)

Input channels: 102 bus signals, plus 16 ext. inputs on pin headers.

Monitored signals: A31-01, D31-00, DS1*, DS0*, AS*, LWORD*, DTACK*, BERR*, 
WRITE*, AM5-0, IRQ7-1*, IACK*, IACKIN, IACKOUT*, BBSY*, 
BR3-0*, BG3- 0IN/OUT*, BCLR*, RETRY*, ACFAIL*, 
SYSFAIL*, SYSRES*, SYSCLK*. BG3-0IN/OUT* also clocked 
separately, encoded and stored as Bus Level, RMW and Block w/
VME64 internally generated.

Trigger: 8 word recognizers covering all 102 VMEbus signals and 16 Ext. 
inputs.
True Range & NOT operator on Address/Data. Edge Triggering.

Range: 8 A64 address ranges, 
8 D64 data ranges. Inside/Outside.

Sequencer: 16 levels with If, Else, Elsif, Goto, Count, Delay, Trigger, Store, Halt.

Trigger position: 0-100%, 1% resolution

Occurrence/ delay counters: 3 x 32-bits

Trigger Output: LVTTL level trigger output with programmable polarity, level or 
pulse. May pulse on each stored sample.
Available on pin header in front panel.

External Inputs: 8 TTL level inputs on pin header
8 TTL level inputs on front panel

Master: Supports normal, block and RMW cycles on any BR level, selectable RMW, ROR, ROC 
release options.

Target: 8MBytes SDRAM memory, with software controlled base address and window size.

VME Violations 60 Protocol Violations and 3 Protocol Warnings

Event counters: 8 x 30-bits.

Real-Time Statistics Counters: 53 x 30-bits counters.

Time Tag: Range: 7.5ns-1172min
Resolution: 7.5ns
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This section is a reference to all the signals used by the Vanguard. All the signals are monitored by 
the analyzer.
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B-1 VME Signals

Address Lines

A01 - A31 (Address)

Address lines that are used to broadcast a short, standard, or extended address.

AM0 - AM5 (Address Modifier)

Used to broadcast information such as address size, cycle type, and/or MASTER 
identification.

DS0*, DS1* (Data Strobe)

Signals used in conjunction with LWORD* and A01 to indicate how many data bytes are 
being transferred.

LWORD* (Longword)

Signal used in conjunction with DS0*, DS1*, and AO1 to select which byte locations within 
the 4 byte group are accessed during the data transfer.

Data Lines

D00 - D31 (Data Bus)

Bidirectional data lines used to transfer data between Masters and Slaves.

Interface Control Lines

AS* (Address Strobe)

A signal that indicates when a valid address has been placed on the address bus.

DS0*, DS1* (Data Strobe)

On Write cycles, the first data strobe falling edge indicates when the Master has placed valid 
data on the data bus. On Read cycles, the first rising edge tells the Slave when it can remove 
valid data from the data bus.

In 2eSST write cycles, both edges of DS1 are used to qualify data.

BERR* (Bus Error)

This signal is generated by a Slave or Bus Timer. This signal indicates to the Master that the 
data transfer was not completed.
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DTACK* (Data Transfer Acknowledge)

The Slave drives DTACK* low to indicate that it has successfully received the data on a 
write cycle. On a read cycle, the Slave drives DTACK* low to indicate that it has placed data 
on the data bus.

In 2eSST read cycles, both edges of DTACK are used to qualify data.

WRITE* 

Used by the Master to indicate the direction of data transfer operations. When WRITE* is 
driven low, the data transfer direction is from the Master to the Slave. When WRITE* is 
driven high, the data transfer direction is from the Slave to the Master.

RETRY*/RESP*

Slaves can request a retry of the transfer by asserting Retry*/Resp*.

Other VME Connector/Pin descriptions

ACFAIL* (AC power failure)

Used to indicate that the AC input to the power supply is no longer being provided or that 
the required AC input voltage levels are not being met.

BBSY* (Bus Busy)

This signal is driven low by the current Master to indicate that it is using the bus.

BCLR* (Bus Clear)

Generated by an Arbiter to indicate when there is a higher priority request for the bus.

BR[3:0]* (Bus Request 0-3)

Generated by Requesters. A low level on one of these lines indicates that some Master needs 
to use the Data Transfer Bus.

IRQ1*-IRQ7* (Interrupt Request)

Generated by an Interrupter, which carry interrupt requests. When several lines are 
monitored by a single Interrupt Handler the highest number line is given the highest priority.

IRQ[7:1]*, the IRQ field can be negated. There are no predefined symbols, but special 
formatting applies. When an IRQ* signal is asserted (i.e. low value), it is displayed with its 
IRQ number, non-asserted, (i.e. high value) are displayed as a dot ".".

For example, IRQ5* asserted, and IRQ1* as don't care, and the rest non-asserted, will be 
displayed "..5...X".
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SYSCLOCK (System Clock)

Provides a constant 16MHz clock signal that is independent of any other bus timing.

SYSFAIL* (System Failure)

Indicates that a failure has occurred in the system and can be generated by any board on the 
VMEbus.

IACK*

Interrupt Acknowledge.

IACKIO*

Interrupt Acknowledge Daisy Chain.

SERA

Serial Bus A.

SERB

Serial Bus B.

SYSRESET*

System Reset.
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AM/XAM

AM[5:0], the Address Modifier bits.

TABLE B-1. AM/XAM codes1

1. nD - Non privileged data
sD - Supervisor data
nP - Non privileged program
sP - Supervisor program
MBLT - 64 Bit block transfers
BLT - up to 32 bit block transfers
LCK - Lock transfer

Predef. Symbol Predef. Symbol

2eVME/2eSST 10000xxxxxxxxx A32sP 001110xxxxxxxx

2eSST 10000x000100xx A32sBLT 001111xxxxxxxx

2eSSTBC 10000x001000xx A64MBLT 000000xxxxxxxx

A32_D64_2eSST 10000000010001 A64D 000001xxxxxxxx

A64_D64_2eSST 10000000010010 A64BLT 000011xxxxxxxx

A32_D64_2eSSTBC 10000000100001 A64LCK 000100xxxxxxxx

A64_D64_2eSSTBC 10000000100010 CS/CSR 101111xxxxxxxx

A32_D32_2eSST 10000100010001 A24LCK 110010xxxxxxxx

A40_D32_2eSST 10000100010010 A24nMBLT 111000xxxxxxxx

A32_D32_2eSSTBC 10000100100001 A24nD 111001xxxxxxxx

A40_D32_2eSSTBC 10000100100010 A24nP 111010xxxxxxxx

2eVME 10000x000000xx A24nBLT 111011xxxxxxxx

A32_D64_2eVME 10000000000001 A24sMBLT 111100xxxxxxxx

A64_D64_2eVME 10000000000010 A24sD 111101xxxxxxxx

A32D32_2eVME 10000100000001 A24sP 111110xxxxxxxx

A40D32_2eVME 10000100000010 A24sBLT 111111xxxxxxxx

A32LCK 000101xxxxxxxx A16nD 101001xxxxxxxx

A32nMBLT 001000xxxxxxxx A16LCK 101100xxxxxxxx

A32nD 001001xxxxxxxx A16sD 101101xxxxxxxx

A32nP 001010xxxxxxxx A40D 110100xxxxxxxx

A32nBLT 001011xxxxxxxx A40LCK 110101xxxxxxxx

A32sMBLT 001100xxxxxxxx A40BLT 110111xxxxxxxx

A32sD 001101xxxxxxxx
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Vanguard Generated Signals

The selection of VME signals presented in each sampling mode (default configuration), has 
been carefully selected to make it convenient to form triggers and storage filters. In addition, 
there are several signals and signal groups that need further discussion.

_D64

Set if 64 bit data transfer.

_D32

Set if 32bit data transfer.

_D64 page 228

_D32 page 228

2eSSTXfer page 229

2eSSTOdd page 229

2eCycle Count page 229

AddrPh page 229

ASToData page 230

Block page 230

BgL page 230

Cycle page 230

DataValid page 230

EXERtrg page 231

Fail page 231

GA[4..0] page 231

Iack (Interrupt Acknowledge) page 232

P2trg page 232

PCHKtrg page 232

RelTime page 233

RMW page 233

Size page 233

SubUnit page 233

Status page 234

Transfer page 234
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2eSSTXfer

2eSST Transfer rate in MBytes/Sec.

2eSSTOdd

2eSST Odd bit. This is fetched from D[4] in address phase 2 during 2eVME/SST cycles.

2eCycle Count

Counts the number of data cycles in a 2eVME/SST transfer. A data cycle contains 2 data 
beats (rising/falling edge). The counter counts down from the loaded cycle count available 
in Address Phase 2. The maximum CycleCount loaded is 0x80 (128), and since there are 2 
data beats per CycleCount, the counter is decremented each 2nd data beat.

AddrPh

In Timing Mode, these signals have the following meaning:

In State Mode only bit 0 is used and has the following meaning:

TABLE B-2. 2eSSTXfer

Predef.
Symbol

SST160 00000 160 MBytes/sec (Maximum)

SST267 00001 267 MBytes/sec

SST320 00010 320 MBytes/sec

3USST80 10000 80 MBytes/sec

3USST133 10001 133 MBytes/sec

3USST160 10010 160 MBytes/sec

TABLE B-3. AddrPh in Timing Mode

Predef.
Symbol

APh 01 2eVME/SST Address Phase 1 / Regular Address Phase

APh2 10 2eVME/SST Address Phase 2

APh3 11 2eVME/SST Address Phase 3

- 00 Not Address Phase

TABLE B-4. AddrPh in State Mode

1

First Data Cycle in a Block/Burst Transfer. Will be set in cycles with only one 
data phase, and in both read and write phase of RMW. Will also be set when 
RETRY or BERR is active in the 2eVME/SST address phase.

0 Remaining Data Cycles in a Block/Burst Transfer.
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ASToData

Number of sampling clocks from AS (Address Strobe) to the first data.

Block

Set when Block/Burst cycle.

BgL

BG[3:0]*, internally latched. This field contains bus grant information latched on the falling 
edge of BBSY*.

Cycle

The Cycle field contains the bus signals that define the current cycle type.

DataValid

Set when there is a data cycle on the bus.

TABLE B-5. BgL signal field

Predef.
Symbol Comment

---0 BG0* active

--1- BG1* active

-2-- BG2* active

3--- BG3* active

---- BG* hidden

TABLE B-6. Cycle field

Predef.
Symbol

Wr x0 Write

Rd x1 Read

RMW 1x Read Modify Write
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EXERtrg

Exerciser cross trigger. The Exerciser activates this signal if the Compare and Test functions 
fail.

Fail

The Fail group contains the two VMEbus fail signals ACFAIL* and SYSFAIL*. 

GA[4..0]

Geographical address for the Master is fetched from the following VME signal lines in 
Address Phase 2 during 2eVME/SST cycles:

GA[4..0], A[23..16]

TABLE B-7. EXERtrg Field

Predef.
Symbol

Trig 1 The Exerciser cross trigger has triggered.

- 0 The Exerciser cross trigger has not triggered.

x x Disable the Exerciser cross trigger cross trigger

TABLE B-8. Fail field

Predef.
Symbol

AcSy 00 Both ACFAIL and SYSFAIL asserted

--Sy 01 SYSFAIL

Ac-- 10 ACFAIL

---- 11 None asserted
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Iack (Interrupt Acknowledge)

Used by an Interrupt Handler to acknowledge an interrupt request. Iack is displayed as a 
numeric code on the signals A[3:1] and driving IACK* low.

P2trg

Cross trigger signal from the P2 Analyzer.

PCHKtrg

Protocol Checker cross trigger. If the Protocol Checker is enabled, then this signal will be 
active when the Protocol Checker has detected a violation.

TABLE B-9. Iack field

Predef.
Symbol

IACK1 0001

IACK2 0010

IACK3 0011

IACK4 0100

IACK5 0101

IACK6 0110

IACK7 0111

Undef 0000

IACKx 0xxx Any IACK

----- 1xxx No IACK

TABLE B-10. P2trg field

Predef.
Symbol

Trig 1 The P2 analyzer has triggered.

- 0 The P2 analyzer has not triggered.

x x Disable the P2 analyzer cross trigger

TABLE B-11. PCHKTrg Field

Predef.
Symbol

Trig 1 The Protocol Checker has triggered.

- 0 The Protocol Checker has not triggered.

x x Disable the Protocol Checker cross trigger
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RelTime

Relative Timetag. The time from the previous to the current sample.

RMW

Set when RMW cycle.

Size

SubUnit

SubUnit number in Master. SubUnit is fetched from A31-A24 in address phase 2 during 
2eVME/SST cycles.

TABLE B-12. Size field

Predef.
Symbol

UNAL3L x000100

UNAL3H x000010

WORD x00x001

UNAL2 x001000

UBYTE x00x011

LBYTE x00x101

D32 xx1xxxx

D64 x1xxxxx
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Status

The bus cycle status field.

Transfer

TABLE B-13. Status field

Predef.
Symbol

Data 1111 Data Transfer

BERR 0011 Bus error

Err 1011 Illegal combination of signals

. . 0111 Idle (not defined)

ARetry 010x Address Retry for 6U

DRetry 000x Data Retry for 6U

DInvalid 110x Data Invalid for 6U

ARetry3U 01x0 Address Retry for 3U

DRetry3U 00x0 Data Retry for 3U

DInvalid3U 11x0 Data Invalid for 3U

TABLE B-14. Transfer Field

Predef.
Symbol Start

Start 11 Start of a Block Transfer

Block 01 Inside a Block 

Single 10 Single Transfer

- 00 Idle
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Exerciser CommandsCycle Sequence 195
EXERtrg 231
EXT.PWR 22
external inputs 20, 49
external power 22

connector 19
external temperature 20

probe 23
external trigger

cable 23

F
Fields 53

adding and removing 54
options 54
properties 56

Fill
command 186

firmware 27
first line 72
fixed IP address 30

G
G/Trig 122

connector 20
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global decoding 71
goto 62

H
HALT

sequencer 63
hardware

description 17
hardware counters 103, 105

I
IF 61
incrementing address 10
input

temperature 20
inputs

external 20, 49
Interrupts

Exerciser 176
interrupts 16
IP address 31

fixed 30

J
jump tools 72, 75

L
LAN

LEDs 20
last line 72
latency

Exerciser 177
LED

dot matrix display 19
system 19

LED display 26
LED Dot Matrix Display 19
line/time 72
Load

command 199
Local

Exerciser 176
Local Copy

command 204
Local Display

Command 201
Local Fill

command 203
Local Load

command 205
Local Modify

command 202
Local Save

command 206
logical operators

for sequencer 63

M
Markers 76

X,Y,Z 72
masks

statistics 87
Master

Exerciser 176
MB/s 89
meters

bus utilization 92
voltage and temperature 83

Modify
command 184

mouse control 36
multiple sessions 39

N
network connection 24
Notes 50

O
OK LED 19
One to One 87, 100
operating modes

protocol checker 119
optx

Exerciser command 180
oscilloscope 122
overhead 91

P
patch 40
patch cords 23
pattern 52
PCI.PWR 22
play statistics 114
power

external source 22
predefined setups 37
protocol checker

classic view 118
options 119
overview 11
reset 119
setup 118

protocol violation
lamp 35

protocol violations
details 120
VME 123

R
range

in event patterns 57
Refresh

command 207
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relative time 69
rescan bus 31
reset

option 27
reset button 19

S
SAM 3
sample rate

statistics 88
sampling

events in sequencer 61
sampling mode 45
Save

Exerciser command 200
save

trace lines 79
scan bus 31
scripts

exerciser 15
selftest 27
sequencer 7

HALT 63
IF,ELSIF,ELSE 61
notation 60
operators 61
sampling 61
setup 64
storing 61
trigger 63

sequencer mode 60
sequncer

syntax 60
sessions

multiple 39
signals

adding 69
removing 69

simulator 31
starting 168

single event mode 59
State Analyzer

options 46
overview 44
setup 45

state analyzer 5
state analyzer module 3
static IP address 30
Statistics

setup 87
statistics

chart files 113
charts 102
customized 103
event selection 87
options 88

overview 13, 85
play 114
pre defined 13
pre-recorded files 114
setup 13
setup files 112
types 86
user defined 14, 103

status 32, 34
bar 34
device in use 31
log 34

store 45
events in sequencer 61

system controller
VME 21

System LEDs 19

T
Target

Exerciser 176
target

memory 15
temperature input 20
templates 38
Test

command 191
time units 68
tools 32
trace

alphanumeric 9
alphanumeric display 67
alphanumeric formatting 71
compare 80
counting 82
display 8
editing 68
formatting 70
jump 72
load 78
navigating 71
new 78
options 68
run 49
save buffer 79
save lines 79
searching 72
show 49
waveform 10
waveform display 75

trace buffer 44
memory 5
save 79
size 46

trace display 67
options 68
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Trig LED 19
trigger 45, 48

conditions 5, 6, 7
in sequencer 63
output 48
position 47

trigger line 72
trigger output 24

U
USB

connection 31
USB Mini-B port 20

V
Vanguard

concept 2
overview 2
status 34

violations
clearing 119

VME
system controller 21

VME protocol violations 123
voltage

meter 83

W
watchdog 27
waveform display 75
workspace 32, 33
Write

command 185

X
x

don’t care 53
X-marker 72

Y
Y-Marker 72
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Ordering Information

Vanguard VME

Vanguard PCI

Related Products

VG-VME VME State Analyzer, 133 MHz Timing Analyzer and Statistics 
Module. This board has NO P0 connector mounted. Includes BusView 
GUI. 

VG-VMEP0
VME State Analyzer, 133 MHz Timing Analyzer and Statistics 
Module. Includes P0 connector to allow Vanguard PMC module to 
access PCI/PCI-X on the P0 connector. Includes BusView GUI.

VG-VP
VMEbus Protocol Checker license key for Vanguard product line.

VG-VE 
Exerciser Module for VG-VME product line.

VG-PMC
PMC State Analyzer and Statistics Module. (Single PMC for all 
functions) Includes BusView GUI. Can operate as P0 PCI/PCI-X Bus 
Analyzer for VG-VMEP0.

VG-PCI
133MHz PCI-X & PCI State Analyzer and Statistics Module for 5V 
and 3.3V systems.
Includes PCI-X carrier, SAM and BusView GUI.

VG-P
PCI-X & PCI Protocol Checker license key for Vanguard product line.

VG-E 
100MHz PCI-X & PCI Exerciser and Compliance Checker license key 
for Vanguard product line.

VG-E2
133MHz PCI-X & PCI Enhanced Exerciser, Error Injector and 
Compliance Checker license key for Vanguard product line.

VG-cPCI
CompactPCI-X & CompactPCI State Analyzer and Statistics Module 
for 5V and 3.3V systems.
Includes cPCI carrier, SAM and BusView GUI.
(See separate data sheet)

VG-PMC
PMC State Analyzer and Statistics Module.
(Single PMC for all functions)
Includes PCI-X carrier, SAM and BusView GUI.
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Individual boards and SAM modules may be purchased separately. Packages are also available. 
Please consult VMETRO.

North and South America

Phone (281) 584-0728
Fax (281) 584-9034
E-mail Support support@vmetro.com
Website www.vmetro.com

Europe and the rest of the world

Phone +47 22 10 60 90
Fax +47 22 10 62 02
E-mail Support support@vmetro.no
Website www.vmetro.com
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Technical Support 

In order for us to provide fast technical support, please provide the following information:

• The version of Busview you are using.
The full version number can be found by clicking About on the Help menu.

• Bus mode used.
• Hardware information (Serial Number, ECO level, etc.).

The hardware information dialog box is opened by clicking the Info button seen in the menu: 
Tools, Hardware.

• Operating System that BusView is running under.
• Status of all LEDs on the board.
• Status of the dot matrix LED display.
• Power and Temperature reading.

These can be found by clicking Voltage and Temperature in the View menu.
• Log files and trace files

 

North and South America

Telephone Support (281) 584-0728
Fax (281) 584-9034
E-mail Support support@vmetro.com
Website www.vmetro.com

Europe and the rest of the world

Telephone Support +47 22 10 60 90
Fax +47 22 10 62 02
E-mail Support support@vmetro.no
Website www.vmetro.com
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American National Standard for 2eSST, ANSI/VITA 1.5-2003

American National Standard for VME64 Extensions, ANSI/VITA 1.1-1997
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